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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly! We
designed Feather to be a new standard for portable microcontroller cores.

This is the Adafruit Feather MO Bluefruit - our take on an 'all-in-one' Cortex MO+ Arduino-compatible + Bluetooth Low
Energy with built in USB and battery charging. Its an Adafruit Feather MO with a BTLE module, ready to rock! We have
other boards in the Feather family, check'em out here (https://adafru.it/jAQ)

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless protocol. In particular, its the only
wireless protocol that you can use with iOS without needing special certification and it's supported by all modern smart
phones. This makes it excellent for use in portable projects that will make use of an iOS or Android phone or tablet. It
also is supported in Mac OS X and Windows 8+

At the Feather MO's heart is an ATSAMD21G18 ARM Cortex MO processor, clocked at 48 MHz and at 3.3V logic, the
same one used in the new Arduino Zero (http://adafru.it/2843). This chip has a whopping 256K of FLASH (8x more than
the Atmega328 or 32u4) and 32K of RAM (16x as much)! This chip comes with built in USB so it has USB-to-Serial
program & debug capability built in with no need for an FTDI-like chip.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer batteries and
built in battery charging. You don't need a battery, it will run just fine straight from the micro USB connector. But, if you
do have a battery, you can take it on the go, then plug in the USB to recharge. The Feather will automatically switch
over to USB power when its available. We also tied the battery thru a divider to an analog pin, so you can measure and
monitor the battery voltage to detect when you need a recharge.

Here's some handy specs! Like all Feather MO's you get:

® Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
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Light as a (large?) feather - 5.7 grams

ATSAMD21G18 @ 48MHz with 3.3V logic/power

256KB of FLASH + 32KB of RAM

No EEPROM

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

8 x PWM pins

10 x analog inputs

Built in 100mA lipoly charger with charging status indicator LED
Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button
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The Feather MO Bluefruit uses the extra space left over to add our excellent Bluefruit BTLE module + two status
indicator LEDs
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The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-function code that can do quite a
lot! For most people, they'll be very happy to use the standard Nordic UART RX/TX connection profile. In this profile,
the Bluefruit acts as a data pipe, that can 'transparently' transmit back and forth from your iOS or Android device. You
can use our iOS App (https://adafru.it/iCi) or Android App (https://adafru.it/f4G), or write your own to communicate with
the UART service (https://adafru.it/iCF).

The board is capable of much more than just sending strings over the air! Thanks to an easy to learn AT command
set (https://adafru.it/iCG), you have full control over how the device behaves, including the ability to define and
manipulate your own GATT Services and Characteristics (https://adafru.it/iCH), or change the way that the device
advertises itself for other Bluetooth Low Energy devices to see. You can also use the AT commands to query the die
temperature, check the battery voltage, and more, check the connection RSSI or MAC address, and tons more. Really,
way too long to list here!

Use the Bluefruit App to get your project started

Using our BluefruitiOS App (https://adafru.it/iCi) or Android App (https://adafru.it/f4G), you can quickly get your project
prototyped by using your iOS or Android phone/tablet as a controller. We have a color picker (https://adafru.it/iCl),
quaternion/accelerometer/gyro/magnetometer or location (GPS) (https://adafru.it/iCl), and an 8-button control game
pad (https://adafru.it/iCl). This data can be read over BLE and piped into the ATSAMD chip for processing & control

You can do a lot more too!

® The Bluefruit can also act like an HID Keyboard (https://adafru.it/iOA) (for devices that support BLE HID)
Can become a BLE Heart Rate Monitor (https://adafru.it/iOB) (a standard profile for BLE) - you just need to add the
pulse-detection circuitry

® Turnitinto a UriBeacon (https://adafru.it/iOC), the Google standard for Bluetooth LE beacons. Just power it and
the 'Friend will bleep out a URL to any nearby devices with the UriBeacon app installed.

® Built in over-the-air bootloading capability so we can keep you updated with the hottest new
firmware (https://adafru.it/iOD). Use any Android or iOS device to get updates and install them. This will update
the native code on the BLE module, to add new wireless capabilities, not program the ATmega chip.

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE. We also
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toss in some header so you can solder it in and plug into a solderless breadboard. Lipoly battery, breadboard and
USB cable not included (but we do have lots of options in the shop if you'd like!)
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The Feather MO Bluefruit is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll take you a
tour of them now!
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery
USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V regulator
3V - this is the output from the 3.3V regulator, it can supply 500mA peak

This is the general purpose I/O pin set for the microcontroller.

All logic is 3.3V
Nearly all pins can do PWM output
All pins can be interrupt inputs

® #0/RX - GPIO #0, also receive (input) pin for Serial1 (hardware UART), also can be analog input

® #1/TX-GPIO #1, also transmit (output) pin for Serial1, also can be analog input
® #20/SDA - GPIO #20, also the 12C (Wire) data pin. There's no pull up on this pin by default so when using with

12C, you may need a 2.2K-10K pullup.

® #21/SCL - GPIO #21, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when using with

12C, you may need a 2.2K-10K pullup.
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® #5-GPIO #5

® #6-GPIO #6

® #9 - GPIO #9, also analog input A7. This analog input is connected to a voltage divider for the lipoly battery so be

aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

#10 - GPIO #10

#11 - GPIO #11

#12 - GPIO #12

#13 - GPIO #13 and is connected to the red LED next to the USB jack

AO - This pin is analog input AO but is also an analog output due to having a DAC (digital-to-analog converter).

You can set the raw voltage to anything from 0 to 3.3V, unlike PWM outputs this is a true analog output

A1thru A5 - These are each analog input as well as digital I/O pins.

® SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use them as everyday GPIO pins
(but recommend keeping them free as they are best used for hardware SPI connections for high speed and are
shared with the BLE)

Bluefruit LE Module + Indicator LEDs

Since not all pins can be brought out to breakouts, due to the small size of the Feather, we use these to control the
BLE module

® #8 - used as the Bluefruit CS (chip select) pin
® #7 - used as the Bluefruit IRQ (interrupt request) pin.
® #4 - used as the Bluefruit Reset pin

Since these are not brought out there should be no risk of using them by accident!

Other Pins!

® RST - this is the Reset pin, tie to ground to manually reset the ATSAMD, as well as launch the bootloader
manually

® ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage (3.3V) but if
you need an alternative analog reference, connect it to this pin and select the external AREF in your firmware.
Can't go higher than 3.3V!

® DFU - this is the force-DFU (device firmware upgrade) pin for over-the-air updates to the Bluefruit module. You
probably don't need to use this but its available if you need to upgrade! Check out the DFU Bluefruit Upgrades
page for how to use it. Otherwise, keep it disconnected.
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SWD Pins

There's two sets of SWD pins. These are used for program/debug of the two processors on the Feather.
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The round pads on the right are for the ATSAMD21G18 (main processor). The rectangular pads to the left are for the
nrf51822 inside the BLE module.

You cannot connect these together to debug both at the same time!

Factory Reset

The (somewhat deceptively labeled) 'Reset' pad on the bottom of the PCB beside SWCLK and SWDIO is for Factory
Reset. Connecting this pad to GND at startup will perform a factory reset, erasing any config settings and may be useful
trying to recover a device in a faulty state. Be sure to remove the connection to GND after the first power cycle.
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Assembly 3% adafruit learning system

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing how to use
and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male headers, this
lets you plug in the Feather into a solderless breadboard
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Another option is to go with socket female headers. This
won't let you plug the Feather into a breadboard but it
will let you attach featherwings very easily
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We also have 'slim' versions of the female headers, that
are a little shorter and give a more compact shape
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Finally, there's the "Stacking Header" option. This one is
sort of the best-of-both-worlds. You get the ability to
plug into a solderless breadboard andplug a
featherwing on top. But its a little bulky

Soldering in Plain Headers

Prepare the header strip:
+ * Cut the strip to length if necessary. It will be easier to
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Add the breakout board:

Place the breakout board over the pins so that the short
pins poke through the breakout pads

++ 21 And Solder!

+ .« Be sure to solder all pins for reliable electrical contact.

: : : : (For tips on soldering, be sure to check out our Guide to
' 21! Excellent Soldering (https://adafru.it/aTk)).
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\ ~ Solder the other strip as well.
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You're done! Check your solder joints visually and
5 o continue onto the next steps
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Tape In Place
For sockets you'll want to tape them in place so when

you flip over the board they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two points on each
strip, to 'tack' the header in place
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And Solder!

Be sure to solder all pins for reliable electrical contact.

(For tips on soldering, be sure to check out our Guide to

Excellent Soldering (https://adafru.it/aTk)).
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You're done! Check your solder joints visually and
continue onto the next steps
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Power
Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery. There's two
ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and the Feather will regulate
the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium lon (Lilon) battery
to the JST jack. This will let the Feather run on a rechargable battery. When the USB power is powered, it will
automatically switch over to USB for power, as well as start charging the battery (if attached) at 100mA. This happens
'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that will only get used when USB

power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the 3.3V regulator and changeover
diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the Reset button). There's also a
CHG LED, which will light up while the battery is charging. This LED might also flicker if the battery is not connected.

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery and is
expecting one to be attached. If there isn't one it may flicker once in a while when you use power because it's
trying to charge a (non-existant) battery. It's not harmful, and its totally normal!

Power supplies

You have a lot of power supply options herel We bring out the BAT pin, which is tied to the lipoly JST connector, as
well as USB which is the +5V from USB if connected. We also have the 3V pin which has the output from the 3.3V
regulator. We use a 500mA peak regulator. While you can get 500mA from it, you can't do it continuously from 5V as it
will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi chip or XBee radio though, since the current
draw is 'spikey' & sporadic.

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell when the
battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for much of the battery life,
then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By measuring the voltage you can quickly
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tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a analog #7 A7).
You can read this pin's voltage, then double it, to get the battery voltage.

#define VBATPIN A7

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
measuredvbat /= 1024; // convert to voltage

Serial.print("VBat: " ); Serial.println(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger output, so its not a good way to
detect if a battery is plugged in or not (there is no simple way to detect if a battery is plugged in)

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to Ground and it will
disable the 3V regulator. The BAT and USB pins will still be powered

Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into the JST portora USB power
cable.

If you need other ways to power the Feather, here's what we recommend:
® For permanent installations, a 5V 1A USB wall adapter (https://adafru.it/duP) will let you plug in a USB cable for
reliable power
® For mobile use, where you don't want a LiPoly, use a USB battery pack! (https://adafru.it/e2q)
® |f you have a higher voltage power supply, use a 5V buck converter (https://adafru.it/DHs) and wire it to a USB
cable's 5V and GND input (https://adafru.it/DHu)

Here's what you cannot do:

® Do not use alkaline or NiMH batteries and connect to the battery port - this will destroy the LiPoly charger and
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there's no way to disable the charger
® Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather /s not designed for external power supplies - this is a design decision to make the board compact and low
cost. It is not recommended, but technically possible:

® Connect an external 3.3V power supply to the 3V and GND pins. Not recommended, this may cause unexpected
behavior and the EN pin will no longer. Also this doesn't provide power on BAT or USB and some
Feathers/Wings use those pins for high current usages. You may end up damaging your Feather.

® Connect an external 5V power supply to the USB and GND pins. Not recommended, this may cause unexpected

behavior when plugging in the USB port because you will be back-powering the USB port, which could confuse
or damage your computer.
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be using
version 1.8 or higher for this guide

https://adafru.it/f1P

https://adafru.it/f1P

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the IDE and navigate
to the Preferences menu. You can access it from the File menu in Windows or Linux, or the Arduino menu on OS X.

- .
9 Blink | Arduino 1.82 ESEE

Edit Sketch Tools Help

Mew Ctrl+M
Open... Ctrl+Q
Open Recent
Sketchbook
Examples
Close Ctrl+W
|| Save Ctrl+5
Save As... Ctrl+Shift+5
1 Page Setup  Cirl+Shift+P
| Print Ctrl+P
i e public domain

Preferences  Ctrl+Comma

Quit Ctrl+Q

= ToUTE T ICEOT I

A dialog will pop up just like the one shown below.
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@ Preferences
Sketchbook location:
/Users [todd/Documents /Arduino

Editor language: = System Default

Editor font size: 10 (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: = None H
Display line numbers
v Verify code after upload

Use external editor

v/ Check for updates on startup

v Update sketch files to new extension on save (.pde -> .ino)

Vv Save when verifying or uploading

Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

More preferences can be edited directly in the file
/Users/todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

Browse

¥ (requires restart of Arduino)

0K Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma separated,
and you will only have to add each URL once. New Adafruit boards and updates to existing boards will automatically be
picked up by the Board Manager each time it is opened. The URLs point to index files that the Board Manager uses to

build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the Arduino IDE
wiki (https://adafru.it/f7U). We will only need to add one URL to the IDE in this example, but you can add multiple URLS
by separating them with commas. Copy and paste the link below into the Additional Boards Manager URLs option in

the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package adafruit_index.json
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Settings | Network

Sketchbook location:

C:\UsersYadyada'\DropboxarduinoSketches
Editor language: :Sysbem Default - (requires restart of Arduino)

Editor font size: 12

Interface scale: Automatic | 100 5% (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: :None -

[ Display line numbers i
[] Enable Code Folding

Verify code after upload

[7] Use external editor

Check for updates on startup

Update sketch files to new extension on save (.pde -= .ino)

Save when verifying or uploagi

Additional Boards Manager URLs:f| https://adafruit.com/package_adafruit_index.json b
H

More preferences can be edited directly in the file Enter a comma separated list of urI;|

C:\Users\adyada\AppData'Local\Wrduino 15\preferences. it (
(edit only when Arduino is not running) i

Here's a short description of each of the Adafruit supplied packages that will be available in the Board Manager when
you add the URL:

Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.
Adafruit SAMD Boards - Includes support for Feather MO and M4, Metro MO and M4, ItsyBitsy MO and M4, Circuit
Playground Express, Gemma MO and Trinket MO

® Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4, Micro and
Leonardo using the arcore project (https://adafru.it/eSl).

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text box separated
by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the Board
Manager.

Now continue to the next step to actually install the board support package!
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* adafruit learning system
Using with Arduino IDE

The Feather/Metro/Gemma/Trinket MO and M4 use an ATSAMD21 or ATSAMD51 chip, and you can pretty easily get it
working with the Arduino IDE. Most libraries (including the popular ones like NeoPixels and display) will work with the
MO and M4, especially devices & sensors that use 12C or SPI.

Now that you have added the appropriate URLs to the Arduino IDE preferences in the previous page, you can open the
Boards Manager by navigating to the Tools->Board menu.

File Edit Sketch [Tools| Help
Auto Format
Archive Sketch
Fix Encoding 8 Reload
1 weid setup Serial Menitor Ctrl+5Shift+ M

Ctrl+T

sketch_now27s

2 /) put y

3 Board: "Arduino/Genuine Uno" Boards Manager...

4

- y Port Arduino AVR Boards

& void loop Programmer: "USBtinyISP" Arduine Yiin

7/ put o " .

; put ¥ Burn Bootloader Arduine/Genuine Uno

: s Arduino Duemilanove or Diecimila

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the window and
select All. You will then be able to select and install the boards supplied by the URLs added to the preferences.

|:| Remember you need SETUP the Arduino IDE to support our board packages - see the previous page on how

to add adafruit's URL to the preferences

Install SAMD Support

First up, install the latest Arduino SAMD Boards (version 1.6.11 or later)

You can type Arduino SAMD in the top search bar, then when you see the entry, click Install

(zo! Boards Ma

Type |&ll v] ‘E&'{er your seardh...

Arduino SAM Boards (32-bits ARM Cortex-M3) by Arduino version 1.6.6 INSTALLED
Boards included in this package:

Arduino Due.

Online hels

More info

m

Arduino SAMD Boards (22-bits ARM Cortex-M0+) by Arduino
Boards included in this package:

Arduino/Genuino Zero.

Online halp

More info

Intel i586 Boards by Intel
Boards included in this package:
Galileo.

More info
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Install Adafruit SAMD

Next you can install the Adafruit SAMD package to add the board file definitions

Make sure you have Type All selected to the left of the Filter your search... box

You can type Adafruit SAMD in the top search bar, then when you see the entry, clickInstall

'

| Type al w» | |Filter pour seardh...

Boards included in this package:

(FTDI). Adafruit Trinket 8MHz, Adafruit Trinket 16MH=.

Online help
More info

l Adafruit Flora, Adafruit Gemma 8MHz, Adafruit Bluefruit Micro, Adafruit Feather 32u4, Adafruit Metro, Adafruit Pro Trinket
5V/16MHz (USB), Adafruit Pro Trinket 3V/12MHz (USB), Adafruit Pro Trinket 5W/16MHz (FTDI), Adafruit Pro Trinket 3V/12MHz

Adafruit SAMD Boards by Adafruit
Boards included in this package:
Adafruit Feather MO.

Online help

More info

Leonardo & Micro MIDI-USB (arcore) by Ralf Kistner

HBoards included in this package:

Arduino Leonarde (MIDI), Arduino Leonardo (MIDI, iPad compatible), Arduino Micro (MIDI).
Online help.

More info

Even though in theory you don't need to - | recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be able to

select and upload to the new boards listed in the Tools->Board menu.
Select the matching board, the current options are:

Feather MO (for use with any Feather MO other than the Express)
Feather MO Express

Metro MO Express

Circuit Playground Express

Gemma MO

Trinket MO

ItsyBitsy MO

Hallowing MO

hacking only)

Metro M4 Express
ItsyBitsy M4 Express
Feather M4 Express
Trellis M4 Express

Grand Central M4 Express
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File Edit Sketch Help

Auto Format Crl+T
Archive Sketch
duuplsiae Fix Encoding & Reload
// Examplefdi Serial Monitor Ctrl+Shift«M | 2F £ 3?5“’-“5
// 18 a diach e mallPlotber Cerl+Shiftel | *F7479-
// For more o A
ety WiFi101 Firmware Updater Adafruit SAMD (32-bits ARM Cortex-M0+ and Cortex-M4) Boards
// Also requi Board: "Adafruit ItsyBitsy M4 (SAMDS1)" y Adafruit Feather MO
// Rdafruic N Port | Adafruit Feather M0 Express
b GetBoardini Adafruithl'!ztn?MO Express
S Adafruit Circuit Playground Express
Programmer: "USBtinyISP" ! Adafruit Gemma MO
#include <Ada) Burn Bootloader Adafruit Trinket M0
: : " Adafruit ItsyBitsy MO
#define NUM _LED 64 // Per strand, Total number of pixels is Adafruit plRkey
// Second argument to constructor is an optional &-byte pin J Adafruit Metro M4 (SAMDS1)
Install Drivers (Windows 7 & 8 Only)
When you plug in the board, you'll need to possibly install a driver
Click below to download our Driver Installer
https://adafru.it/ECO
https://adafru.it/ECO
Download and run the installer
r R
Cpening adafruit_drivers.exe g

You have chosen to open:
== adafruit_drivers.exe
which is: Binary File (13,6 MB)

from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

’ Save File ] L Cancel J

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the license

© Adafruit Industries

-
* Adafruit Board Drfvem:Ecense Agreement = | —

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

h’his program will allow you to install Windows drivers for i
hardware that Adafruit Industries produces. Please support U
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

Note you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

Cancel | Mullsoft Install System v3,0b3 I Agree
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Select which drivers you want to install, the defaults will set you up with just about every Adafruit board!

Chedk the board drivers below that you would like to install. Click install to

start the installation.

Select board drivers to install:

Feather 32u4, Feather M0, Feather MO Ex
Feather WICED
Trinket / Pro Trinket f Gemma (USBtinyISP)

] Arduine Gemma
] Feather HUZZAH ESPE266 (SiLabs CP210x]
] Metro 328 / Metro Mini 328 (FTDI VCP and

< i »

Cancel | Mullsaft Inskall Systermn w302, 1

Click Install to do the installin'

< Back | Install I

-~
s Adafruit Board Drivers: &:mpleted_élﬂﬂ

Completed

Show details |

Cancel | tullsoft Install System «3,0b3

< Back

Blink

Now you can upload your first blink sketch!

Plug in the MO or M4 board, and wait for it to be recognized by the OS (just takes a few seconds). It will create a
serial/COM port, you can now select it from the drop-down, it'll even be 'indicated' as
Trinket/Gemma/Metro/Feather/ItsyBitsy/Trellis!

A7 put your

}

wvoid loopi) {
A7 put your

Board: "Adafruit Feather..."
Port: "COMS2 (Adafruit ..."

Programmer: "AVRISP mkdl"

Burn Bootloader

(@ sketch_nov23a | Arduino 164 =)
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
Sketeh_nov2ag Fix Encoding & Reload
void setup{) Serial Monitor Ctrl+Shift+M i

Serial ports
ComML
v COMS2 (Adafruit Feather MO (Mative USE Port))
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Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.

If you're using Trellis M4 Express, you can go to the next page cause there's no pin 13 LED - so you won't see it blink.
Still this is a good thing to test compile and upload!

|:| If you are having issues, make sure you selected the matching Board in the menu that matches the hardware

you have in your hand.

Successful Upload

If you have a successful upload, you'll get a bunch of red text that tells you that the device was found and it was
programmed, verified & reset

Adafruit Feather MO (Nati ) on COMSS

After uploading, you may see a message saying "Disk NotEjected Properly" about the ...BOOT drive. You can ignore
that message: it's an artifact of how the bootloader and uploading work.
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Compilation Issues

If you get an alert that looks like

Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit SAMD board

packages

Fm-none i imarm-none

{runtim

Adafruit Feather M

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot

into the bootloader, click the RST button twice (like a double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

Auto Format Cirl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+Shift«M = board
Board: "Adafruit Feather M0 (MNative USE Port)" L3
Port L Serial ports

com

Programmer: "USBtinyISP" [
comi2

Burn Bootloader
f/ turn the LED on (HIGH is the volcoge =cvezr
/ wait for

// turn the

f by making the woltage LOW

COMI129 (Adafruit Feather MO (Mative USE Port])

You may need to go back and reselect the 'normal' USB serial port next time you want to use the normal upload.

Ubuntu & Linux Issue Fix

Follow the steps for installing Adafruit's udev rules on this page. (https://adafru.it/iOE)
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ﬁ adafruit learning system
Adapting Sketches to MO &
M4

The ATSAMD21 and 51 are very nice little chips, but fairly new as Arduino-compatible cores go. Most sketches &
libraries will work but here’s a collection of things we noticed.

The notes below cover a range of Adafruit MO and M4 boards, but not every rule will apply to every board (e.g. Trinket
and Gemma MO do not have ARef, so you can skip the Analog References notel).

Analog References

If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is analogReference(AR_EXTERNAL)
(it's AR_EXTERNAL not EXTERNAL)

Pin Outputs & Pullups

The old-style way of turning on a pin as an input with a pullup is to use

pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register on 8-bit AVR chips is the same as the output-selection register.
For MO & M4 boards, you can't do this anymore! Instead, use:
pinMode(pin, INPUT_PULLUP)

Code written this way still has the benefit of being backwards compatible with AVR. You don’t need separate versions
for the different board types.

Serial vs SerialUSB

99.9% of your existing Arduino sketches use Serial.print to debug and give output. For the Official Arduino SAMD/MO
core, this goes to the Serial5 port, which isn't exposed on the Feather. The USB port for the Official Arduino MO core is
called SerialUSB instead.

In the Adafruit MO/M4 Core, we fixed it so that Serial goes to USB so it will automatically work just fine.

However, on the off chance you are using the official Arduino SAMD core and notthe Adafruit version (which really,
we recommend you use our version because it’s been tuned to our boards), and you want your Serial prints and
reads to use the USB port, use SerialUSB instead of Serialin your sketch.

If you have existing sketches and code and you want them to work with the MO without a huge find-replace, put
#if defined(ARDUINO_SAMD_ZERO) && defined(SERIAL_PORT_USBVIRTUAL)
// Required for Serial on Zero based boards

#define Serial SERIAL_PORT_USBVIRTUAL
#endif

right above the first function definition in your code. For example:
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File Edit Sketch Tools Help

datecale §

1|// Simple date conversions and calculations

Lo »

I 3 |#include <Wire.h>

4 #include "RIClib.h"

& #if defined (ARDUINO_ARCH_SAMD)

7|/f for Zero, output cn USB Serial console, remove line below if using programming port to program the Zero!
8 #define Serial SerialUSB
9 #endif
11 |void showDate {const char* txt, const DateTimes dt) {
Serial.print(txt);

13 Serial.print{’ '):

AnalogWrite / PWM on Feather/Metro MO

After looking through the SAMD21 datasheet, we've found that some of the options listed in the multiplexer table don't
exist on the specific chip used in the Feather MO.

For all SAMD21 chips, there are two peripherals that can generate PWM signals: The Timer/Counter (TC) and
Timer/Counter for Control Applications (TCC). Each SAMD21 has multiple copies of each, called 'instances'.

Each TC instance has one count register, one control register, and two output channels. Either channel can be enabled
and disabled, and either channel can be inverted. The pins connected to a TC instance can output identical versions of

the same PWM waveform, or complementary waveforms.

Each TCC instance has a single count register, but multiple compare registers and output channels. There are options
for different kinds of waveform, interleaved switching, programmable dead time, and so on.

The biggest members of the SAMD21 family have five TC instances with two 'waveform output' (WO) channels, and
three TCC instances with eight WO channels:

e TC[0-4],WO[0-1]
e TCC[0-2],WO[0-7]

And those are the ones shown in the datasheet's multiplexer tables.

The SAMD21G used in the Feather MO only has three TC instances with two output channels, and three TCC instances
with eight output channels:

e TC[3-5],WO[0-1]
e TCC[0-2],WO[0-7]

Tracing the signals to the pins broken out on the Feather MO, the following pins can't do PWM at all:
® Analog pin A5

The following pins can be configured for PWM without any signal conflicts as long as the SPI, I12C, and UART pins keep
their protocol functions:

® Digital pins 5, 6, 9, 10, 11, 12, and 13
® Analog pins A3 and A4

If only the SPI pins keep their protocol functions, you can also do PWM on the following pins:
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® TX and SDA (Digital pins 1and 20)

analogWrite() PWM range

On AVR, if you set a pin's PWM with analogWrite(pin, 255) it will turn the pin fully HIGH. On the ARM cortex, it will set
it to be 255/256 so there will be very slim but still-existing pulses-to-OV. If you need the pin to be fully on, add test
code that checks if you are trying to analogWrite(pin, 255) and, instead, does a digitalWrite(pin, HIGH)

analogWrite() DAC on AO

If you are trying to use analogWrite() to control the DAC output on AO, make sure you do not have a line that sets the
pin to output. Remove. pinMode(A0, OUTPUT).

Missing header files

There might be code that uses libraries that are not supported by the MO core. For example if you have a line with

#include <util/delay.h>

you'll get an error that says

fatal error: util/delay.h: No such file or directory
#include <util/delay.h>

~

compilation terminated.
Error compiling.

In which case you can simply locate where the line is (the error will give you the file name and line number) and 'wrap
it" with #ifdef's so it looks like:

#1if !defined (ARDUINO ARCH SAM) && !defined (ARDUINO ARCH SAMD) && !'defined(ESP8266) &&
!defined (ARDUINO ARCH STM32F2)

#include <util/delay.h>

#endif

The above will also make sure that header file isn't included for other architectures

If the #include is in the arduino sketch itself, you can try just removing the line.

Bootloader Launching

For most other AVRs, clicking reset while plugged into USB will launch the bootloader manually, the bootloader will
time out after a few seconds. For the MO/M4, you'll need to double click the button. You will see a pulsing red LED to
let you know you're in bootloader mode. Once in that mode, it wont time out! Click reset again if you want to go back to
launching code.

Aligned Memory Access

This is a little less likely to happen to you but it happened to me! If you're used to 8-bit platforms, you can do this nice
thing where you can typecast variables around. e.g.

uint8_t mybuffer[4];
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float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer might not be aligned to a 2 or 4-byte
boundary. The ARM Cortex-MO can only directly access data on 16-bit boundaries (every 2 or 4 bytes). Trying to access
an odd-boundary byte (on a 1 or 3 byte location) will cause a Hard Fault and stop the MCU. Thankfully, there's an easy
work around ... just use memcpy!

uint8_t mybuffer[4];

float f;
memcpy(&f, mybuffer, 4)

Floating Point Conversion

Like the AVR Arduinos, the MO library does not have full support for converting floating point numbers to ASCII strings.
Functions like sprintf will not convert floating point. Fortunately, the standard AVR-LIBC library includes the dtostrf
function which can handle the conversion for you.

Unfortunately, the MO run-time library does not have dtostrf. You may see some references to using #include
<avr/dtostrf.h> to get dtostrf in your code. And while it will compile, it does not work.

Instead, check out this thread to find a working dtostrf function you can include in your code:

http://forum.arduino.cc/index.php?topic=368720.0 (https://adafru.it/IFS)

How Much RAM Available?

The ATSAMD21G18 has 32K of RAM, but you still might need to track it for some reason. You can do so with this handy
function:

extern "C" char *sbrk(int 1i);

int FreeRam () {

char stack dummy = 0;

return &stack dummy - sbrk(0);
}

Thx to http://forum.arduino.cc/index.php?topic=365830.msg2542879#msg2542879 (https://adafru.it/m6D) for the tip!

Storing data in FLASH

If you're used to AVR, you've probably used PROGMEM to let the compiler know you'd like to put a variable or string in
flash memory to save on RAM. On the ARM, its a little easier, simply add const before the variable name:

const char str[] = "My very long string";

That string is now in FLASH. You can manipulate the string just like RAM data, the compiler will automatically read from
FLASH so you dont need special progmem-knowledgeable functions.

You can verify where data is stored by printing out the address:
Serial.print("Address of str $"); Serial.printin((int)&str, HEX);

If the address is $2000000 or larger, its in SRAM. If the address is between $0000 and $3FFFF Then it is in FLASH
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Pretty-Printing out registers

There's a /ot of registers on the SAMD21, and you often are going through ASF or another framework to get to them.
So having a way to see exactly what's going on is handy. This library from drewfish will help a ton!

https://github.com/drewfish/arduino-ZeroRegs (https://adafru.it/Bet)

M4 Performance Options

As of version 1.4.0 of the Adafruit SAMD Boards package in the Arduino Boards Manager, some options are available
to wring extra performance out of M4-based devices. These are in the Tools menu.

Sketch WELLIEE Help

CPU Speed: "200 MHz (overclock)"

v 200 MHz (overclock)

All of these performance tweaks involve a degree of uncertainty. There’s no guarantee of improved performance in
any given project, and some may even be detrimental, failing to work in part or in whole. If you encounter trouble,
select the default performance settings and re-upload.

Here’s what you get and some issues you might encounter...

CPU Speed (overclocking)

This option lets you adjust the microcontroller core clock...the speed at which it processes instructions...beyond the
official datasheet specifications.

Manufacturers often rate speeds conservatively because such devices are marketed for harsh industrial environments...
if a system crashes, someone could lose a limb or worse. But most creative tasks are less critical and operate in more
comfortable settings, and we can push things a bit if we want more speed.

There is a small but nonzero chance of code locking up or failing to run entirely. If this happens, try dialing back the
speed by one notch and re-upload, see if it's more stable.

Much more likely, some code or libraries may not play well with the nonstandard CPU speed. For example, currently
the NeoPixel library assumes a 120 MHz CPU speed and won’t issue the correct data at other settings (this will be
worked on). Other libraries may exhibit similar problems, usually anything that strictly depends on CPU timing...you
might encounter problems with audio- or servo-related code depending how it’s written. If you encounter such code or
libraries, set the CPU speed to the default 120 MHz and re-upload.

Optimize
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There’s usually more than one way to solve a problem, some more resource-intensive than others. Since Arduino got
its start on resource-limited AVR microcontrollers, the C++ compiler has always aimed for the smallest compiled
program size. The “Optimize” menu gives some choices for the compiler to take different and often faster approaches,
at the expense of slightly larger program size...with the huge flash memory capacity of M4 devices, that’s rarely a
problem now.

The “Small” setting will compile your code like it always has in the past, aiming for the smallest compiled program size.

The “Fast” setting invokes various speed optimizations. The resulting program should produce the same results, is
slightly larger, and usually (but not always) noticably faster. It's worth a shot!

“Here be dragons” invokes some more intensive optimizations...code will be larger still, faster still, but there’s a
possibility these optimizations could cause unexpected behaviors. Some code may not work the same as before.
Hence the name. Maybe you’ll discover treasure here, or maybe you’ll sail right off the edge of the world.

Most code and libraries will continue to function regardless of the optimizer settings. If you do encounter problems,dial
it back one notch and re-upload.

Cache

This option allows a small collection of instructions and data to be accessed more quickly than from flash memory,
boosting performance. It's enabled by default and should work fine with all code and libraries. But if you encounter
some esoteric situation, the cache can be disabled, then recompile and upload.

Max SPI and Max QSPI

These should probably be left at their defaults. They’re present mostly for our own experiments and can cause
serious headaches.

Max SPI determines the clock source for the M4’s SPI peripherals. Under normal circumstances this allows transfers up
to 24 MHz, and should usually be left at that setting. But...if you're using write-only SPI devices (such as TFT or OLED
displays), this option lets you drive them faster (we’ve successfully used 60 MHz with some TFT screens). The caveat is,
if using any read/write devices (such as an SD card), this will not work at all...SP| reads absolutely max out at the default
24 MHz setting, and anything else will fail. Write = OK. Read = FAIL. This is true even if your code is using a lower
bitrate setting..just having the different clock source prevents SPI reads.

Max QSPI does similarly for the extra flash storage on M4 “Express” boards. Very few Arduino sketches access this
storage at all, let alone in a bandwidth-constrained context, so this will benefit next to nobody. Additionally, due to the
way clock dividers are selected, this will only provide some benefit when certain “CPU Speed” settings are active. Our
PyPortal Animated GIF Display (https://adafru.it/EKO) runs marginally better with it, if using the QSPI flash.

Enabling the Buck Converter on some M4 Boards

If you want to reduce power draw, some of our boards have an inductor so you can use the 1.8V buck converter instead
of the built in linear regulator. If the board does have an inductor (see the schematic) you can add the line SUPC-
>VREG.bit.SEL = 1; to your code to switch to it. Note it will make ADC/DAC reads a bit noisier so we don't use it by
default. You'll save “4mA (https://adafru.it/FOH).
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* adafruit learning system
Installing BLE Library

Install the Adafruit nRF51 BLE Library

In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based modules such as this
one (a.k.a. Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (https://adafru.it/f4V) but its likely easier to just download by clicking:
https://adafru.it/f4W
https://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Adafruit_BluefruitLE_nRF51 folder
contains Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolderl/libraries/ folder.
You may need to create the libraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (https://adafru.it/aYM)

After restarting, check that you see the library folder with examples:

Adafruit_ 9DOF

Edit Sketch Tools Help Adafruit_ADS1015
Mew Ctrl+M Adafruit_ADXL345_U
Open Ctrl+0 Adafruit_AHRS
Sketchbook Adafruit_AM2315
— Adafruit_AS3935
Adafruit_BLEFirmata
Close Ctrl+ W AR EEERma
Adafruit_BLEModule_SPISlave
Save Ctrl+5 . .
Adafruit_BluefruitLE_nRF51 atcommand
Save As... Ctrl+5hift+5 .
Adafruit_BMPOES beacon
Upload Ctrl+U
preed e Adafruit BMPOBS_Unified bleuart
Uplead Using Programmer  Ctrl+5Shift+U Adafruit BMP183 factoryreset
Page Setup Ctrl+Shift+P Adafruit_BMP183_Unified heartratemonitor
Print Ctrl+P Adafruit_BNO055 hidkeyboard
Adafruit_CAP1188 -
Preferences Ctrl+ Comma oo o L uribeacon

Run first example

Lets begin with the beginner project, which we can use to do basic tests. To open the ATCommand sketch, click on
the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select atcommand:
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Adafruit AHRS »
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit BMP085_Unified »> beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNO055 > factoryreset
Adafruit_ CC3100 »> heartratemonitor
Adafruit DHT_Unified > hidkeyboard
Adafruit_DotStar » uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:

- k!
atcommand | Arduine 1.6.4 R E@g
File Edit Sketch Tools Help

atcommand

Afile atcommand. ino
@author  hathach

m

Thizs example shows how to comnect to your Adafruit Blusfruit LE (nef£Sl82Z2) and do
gome basic AT commands to check commectivity, print out the version strings and let
|| Fou gend your own AT conmards!

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARTANT ARDUINO_DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit BELE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE TUART.h"

=

/4 IE you are using Software Serial....
/7 The following macros declare the pins used for 5W serial, you should
ff/ use these pins if you are commecting the UART Friend to an UNOD

#define BELUEFRUIT SWUART FxD_PIN 9 J/ Required for software serial!
|| 44 fim- DITEETHITT emmTanT TWm nTe in S Timemadamd Foa emEbemosn omand ol i
4| [T b

Arduine Uno ¢

|:| Don't upload the sketch yet! You will have to begin by changing the configuration.

Go to the second tab labeled BluefruitConfig.h and find these lines
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// SHARED SPI SETTINGS

[ e e e e e eeoooooo---o-o---
// The following macros declare the pins to use for HW and SW SPI communication.

// SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when

// using HW SPI. This should be used with nRF51822 based Bluefruit LE modules

// that use SPI (Bluefruit LE SPI Friend).

[/ e ooosooooooooooooooooooooooo-
#define BLUEFRUIT_SPI_CS 8

#define BLUEFRUIT_SPI_IRQ 7

#define BLUEFRUIT SPI RST 6 // Optional but recommended, set to -1 if unused

And change (if it isnt already) the last line to:

#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1 if unused

(The Bluefruit Feather has the reset on digital #4 not #6)

Now go back to the main tab atcommand and look for this line of code

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);

Make sure that the second line is uncommented (it should be)

|:| OK now you can upload to the Bluefruit Feather!

If you're using Ubuntu 15.04 or other Linux distributions and run into errors attempting to upload a program to
|:| the board, scroll up to the Ubuntu and Linux issue fix in the previous section

Uploading to the Feather Bluefruit LE

It's pretty easy to upload, first up make sure you have Adafruit Feather MO selected on the boards dropdown

r = - - Arduinc Hobot Motor
sketch_nov23a | Arduino 1.6.4 Arduing G
rduino Gemma
File Edit Sketch |T Is| Hel,
re o ep Adafruit Feather boards
Cuiolionnat GnET Adafruit Feather
Archive Sketch
cketch noy23s renne SkEre Adafruit SAMD Boards
- i Fix Encoding & Reload
. peEneeding & Reos © | Adafruit Feather MO (Native USE Port)
vold setup() Serial Monitor Ctrl+ Shift+ M
S/ put your ESPE266 Modules
Board: "Adafruit Feather..." Generic ESPE266 Module
i ! Port: "COMS52 (Adafruit .." Adafruit HUZZAH ESPE266
roi ModeMCU 0.9 (ESP-12 Modul
vold leopi) | Programmer: "AVRISP mid” ode ( odule)
\| // put your NodeMCU 1.0 (ESP-12E Module)
Burn Bootloader
il . Olimex MOD-WIFI-ESP8266(-DEV)

Also, in the Ports menu, look for the port labeled as such:
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( sketch_nov23a | Arduino 1.6.4 = [ E [ |
File Edit Sketch Help
Auto Format Ctrl+T E
Archive Sketch
sketch_novi3z Fix Encoding & Reload n
vold setup() Serial Monitor Ctrl+ Shift+ M i
#f put your
Board: "Adafruit Feather..." L4
! Port: "COMS52 (Adafruit ..." ) Serial ports
'11 Ltoopt) { Programmer: "AVRISP mkII" [ comL
Afput your v COMS2 (Adafruit Feather MO (Mative USE Port))
Burn Bootloader
1 I

Now click the upload button on the Arduino IDE (orFile Menu -> Upload)

If all is good you will see Done Uploading in the status bar

F b I TR e
atcommand | Arduino 1.6.4 o

File Edit Sketch Tools Help

atcammand | BILERFUIE aRfioh

O = M 1 s L) Y =

.C.
10
11
12
13
14

15 Hirncloda Ahrdaina ko

rebuildin

Ad afruit Bluefruit b
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ve USBE Port) on COMSS

Compilation Issues

If you get an alert that looks like
Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit SAMD board
packages

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot
into the bootloader, click the RST button twice (like a double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once itis in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

( 22 sketch_nov27a | Arduino 1.6.3
File Edit Sketch Help

Auto Format Cirl+T F
Archive Sketch
Fix Encoding & Reload

sketch_nov27z

1// the set Serial Monitor Ctrl+Shift+M = board
2 id setug
3 initi Board: "Adafruit Feather M0 (Native USE Port)" 4
5 ° Port L Serial ports
B . oML
Programmer: "USBtinyISP"
comiz
Burn Bootloader
COM129 (Adafruit Feather MO (Native USE Port])

. HIGH): £/ turn the LED on (HIGH is the volcoge zovezr

) off by making the voltage LOW

You may need to go back and reselect the 'normal' USB serial port next time you want to use the normal upload.

Run the sketch

OK check again that the correct port is selected
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-
sketch_nov23a | Arduino 1.6.4 - = | =
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
skeich_nov23 Fix Encoding & Reload
void setup() Serial Monitor Ctrl+ Shift+ i
A7 put your
Board: "Adafruit Feather..." L4
! Port: "COM52 (Adafruit..." Serial ports
woi COomML
void loop() { Programmer: "AVRISP mkIl"
| A put your v' COMS2 (Adafruit Feather MO (MNative USE Port))
Burn Bootloader

' !
gl

Then open up the Serial console. You will see the following:

F ™
@ COMSS (Adafruit Bluefruit Mi [E=EE
. (Adafruit Bluefruit Micro) .

2dafruit Bluefruit AT Command Example
Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- OK
Requesting Bluefruit info:
BLESPIFRIEND
nRF51822 QFACALO
6992A797D32E2839
0.6.5
| |
0.6.5
Jul 1 2015
5110 &.0.0, 0.2

Autoscrol BothNL&CR  » | 115200 baud

This sketch starts by doing a factory reset, then querying the BLE radio for details. These details will be useful if you are

debugging the radio. If you see the information as above, you're working! (Note that the dates and version numbers
may vary)

AT command testing

Now you can try out some AT commands - check the rest of the learn guide for a full list. We'll just start with
AT+HWGETDIETEMP which will return the approximate ambient temperature of the BLE chipset
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.
COMSS (Adafruit Bluefruit Micro) Lol o

AT +HWGETDIETEMP

2dafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- 0K

Requesting Bluefruit info:
BLESPIFRIEND

nRF51822 QFACALO
B992AT9TD3I2E2E39

0.6.5

0.8.5

Jul 1 2015
5110 &.0.0, 0.2

Autoscroll

R
COMEB (Adafruit Bluefruit Micro] - h@ﬂg

Performing a factory reset: -
AT+FACTORYRESET

<- 0K
ATE=0

<- OK

Requesting Bluefruit info:
BLESPIFRIEND

nRF51822 QFACALQ
6992RA797D32E2E839

0.6.5

0.8.5

Jul 1 2015

5110 &.0.0, 0.2

m

i
W
1

Autoscrol BothNL&CR » | 115200 baud

OK now you know how to upload/test/communicate with your Feather MO Bluefruit. Next up we have a bunch of
tutorials who can follow for checking out the bluetooth le radio and apps.

For all the following examples, we share the same code between various modules sodon't forget to make sure
you have the RESET pin set to 4 in BluefruitConfig.h for each sketch before uploading, and that
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Hardware SPI mode is selected by checking for

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);
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ﬁ adafruit learning system
Configuration!

|:| Before you start uploading any of the example sketches, you'll need to CONFIGURE the Bluefruit interface -

there's a lot of options so pay close attention!

Which board do you have?

There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you have an
SPI-connected NRF51822 module. You can use this with
Atmega328 (Arduino UNO or compatible), ATmega32u4
(Arduino Leonardo, compatible) or ATSAMD21 (Arduino
Zero, compatible) and possibly others.

Your pinouts are Hardware SPI,CS=8,IRQ=7,RST =4

Bluefruit Micro or Feather 32u4 Bluefruit
If you have a Bluefruit Micro or Feather 32u4 Bluefruit LE
0000000 0 . then you have an ATmega32u4 chip with Hardware SPI,

En e a4 ~10 g~ £ ™

el L B TR CS=8,IRQ=7,RST =4
F eathisr = -
Bluefrii s

adafruit

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le Page 55 of 223


https://learn.adafruit.com/assets/29590
https://learn.adafruit.com/assets/29592

Feather MO Bluefruit LE

If you have a Feather MO Bluefruit LE then you have an
ATSAMD21 chip with Hardware SPI, CS=8,IRQ =7,
RST=4

Bluefruit LE SPI Friend

If you have a stand-alone module, you have a bit of
flexibility with wiring however we strongly recommend
Hardware SPI, CS=8,IRQ=7,RST =4

You can use this with just about any microcontroller with

5 or 6 pins
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Bluefruit LE UART Friend or Flora BLE

If you have a stand-alone UART module you have some
flexibility with wiring. However we suggest hardware
UART if possible. You will likely need to use the flow
control CTS pin if you are not using hardware UART.
There's also a MODE pin

You can use this with just about any microcontroller with
at least 3 pins, but best used with a Hardware
Serial/lUART capable chip!

Configure the Pins Used

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the sketch to your
own documents folder once set up.

-
atcommand | Ardui E@g

File Edit Sketch Tools Help

BluefruitConfig.h
J COMMON SETTINGS

»

I

/4 These settings are used in both 5W UART, HW UART and SPI mode

1 =
#define BUFSTZE 1z8 /4 Size of the read buffer for incoming data 1
#define VEREOSE_MODE true J/ If set to 'true' enables debug output

/4 SOFTWAEE UART SETTINGS
1
/4 The following macros declare the pins that will be used for '5W' serial.

/4 Tou should use this option if wou are comnecting the UART Friend to an UNO
I
#define BLUEFEUIT_SWUART FXD_PIN 9 J/f FRequired for software serial!

HAAFime DTTEERIITT SUITATT T TTH in B L N N
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to have full debug
output. Debug output is 'noisy' on the serial console but is handy since you can see all communication between the
micro and the BLE

[/ m e e e e e e e e e e e e e e e e e e e e e e e eeoeo-o---------
// These settings are used in both SW UART, HW UART and SPI mode

/] mm e eeooooososo-o-o-----
#define BUFSIZE 128 // Size of the read buffer for incoming data
#define VERBOSE MODE true // If set to 'true' enables debug output

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and CTS flow control. Some
microcontrollers are limited on which pins can be used! Check the SoftwareSerial library documentation for more
details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT SWUART RXD PIN 9 // Required for software serial!
#define BLUEFRUIT_SWUART_TXD PIN 10 // Required for software serial!
#define BLUEFRUIT UART CTS PIN 11  // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN -1 // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Seriall - you can set that up here:

// HARDWARE UART SETTINGS

#ifdef Seriall // this makes it not complain on compilation if there's no Seriall
#define BLUEFRUIT HWSERIAL NAME Seriall

#endif

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few sketches that dont
use it, instead depending on commands to set/unset the mode. Its best to use the MODE pin if you have a GPIO to
spare!

#define BLUEFRUIT_UART_MODE_PIN 12 // Set to -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set the CS (chip select) line, IRQ (interrupt request) line and if you
have a pin to spare, RST (Reset)

// SHARED SPI SETTINGS

#define BLUEFRUIT SPI CS 8
#define BLUEFRUIT SPI IRQ 7
#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1 if unused
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Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but very flexible

// SOFTWARE SPI SETTINGS

#define BLUEFRUIT_SPI_SCK 13
#define BLUEFRUIT_SPI_MISO 12
#define BLUEFRUIT_SPI_MOSI 11

|:| Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the HW you are using:
SPI both hardware and software type, and UART both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can use either software serial or hardware serial. Hardware
serial is higher quality, and less risky with respect to losing data. However, you may not have hardware serial available!
Software serial does work just fine with flow-control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial contructor below, and
make sure the other three options (hardware serial & SPI) are commented out.

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial(BLUEFRUIT SWUART TXD PIN, BLUEFRUIT SWUART RXD PIN);

Adafruit BluefruitLE UART ble(bluefruitSS, BLUEFRUIT UART MODE PIN,
BLUEFRUIT UART CTS PIN, BLUEFRUIT UART RTS PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial constructor, and make
sure the other three options are commented out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */
Adafruit BluefruitLE UART ble(BLUEFRUIT HWSERIAL NAME, BLUEFRUIT UART MODE PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure the other constructors
are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);

If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI transfers via the following
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constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */
Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI SCK, BLUEFRUIT SPI MISO,

BLUEFRUIT SPI MOSI, BLUEFRUIT SPI CS,

BLUEFRUIT SPI IRQ, BLUEFRUIT SPI RST);
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ﬁ adafruit learning system
ATCommand

The ATCommand example allows you to execute AT commands from your sketch, and see the results in the Serial
Monitor. This can be useful for debugging, or just testing different commands out to see how they work in the real
world. It's a good one to start with!

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select atcommand:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library » bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 3 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:
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.
atcommand | Arduine 1.6.4 R — @M

File Edit Sketch Tools Help

atcommand

fEl
Afile atcommand. ino
@author  hathach

m

This exanple shows how to comnect to your Adafruit Blusfruit LE (nrf51822) and do
gome basic AT commands to check commectivity, print out the version strings and let
ywou send your own AT conmands!

*/

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARTANT_ARDUINO_DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit_ELE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE UART.h"

S4 TE you are using Software Serial....

/7 The following macros declare the pins used for 5W serial, you should

/7 usge these pins if you are connecting the UART Friend to an UNO

#define BLUEFRUIT SWUART RxD_FIN 9 J/ Required for software serial!

HAr£im- DITTRIITT CIMTART TWT TTH N {4 Timemaiand Eow e femroan sewd ol {

4| n +

Arduine Uno ¢

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do
not configure & connect a MODE pin

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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2% COM250 (Adafruit Florz

|

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module:
ATZ

<- 0K

QK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- RATE=0

QK

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B19EE
0.6.2

0.68.2

Rpr 30 2015

5110 &.0.0, 0.2
Mok

Autoscroll

iNohneenmng -  i9600baud -

To send an AT command to the Bluefruit LE module, enter the command in the textbox at the top of the Serial Monitor
and click the Send button:

ATI Send

The response to the AT command will be displayed in the main part of the Serial Monitor. The response from 'ATI' is
shown below:
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r

/dev/cu.usbmodem1411131

_Send

BLE AT COMMAND EXAMPLE

Performing a factory reset: OK!
BLEFRIEND32

nRF51822 QFACAl@
DEB72C43325A171B

8.6.5

@.6.5

Apr 30 2015

5110 8.9.9, 0.2

AT = ATI

BLEFRIEND32
nRF51822 QFACA10
DEB72(43325A171B
9.6.5

8.6.5

Apr 30 2015

5110 8.9.9, 0.2
0K

AT =

Initialising the Bluefruit LE module: OK!

™ Autoscroll You've pressed Send b...

| No line ending

¢ | 115200 baud

You can do pretty much anything at this prompt, with the AT command set. Try AT+HELP to get a list of all commands,
and try out ones like AT*HWGETDIETEMP (get temperature at the nRF51822 die) and AT+HWRANDOM (generate a

random number)

-

COM250 (Adafruit Flora)

e

© Adafruit Industries
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OK

BLEFRIEND32
nRF31822 QFRCRI1O0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2

AT > AT+HWRANDOM

<- (0xASR3DEF1

AT > AT+HWGETDIETEMF

Requesting Bluefruit info:

FY

Autoscroll

No line ending

~ 9600 baud
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ﬁ adafruit learning system
BLEUart

The BLEUart example sketch allows you to send and receive text data between the Arduino and a connected
Bluetooth Low Energy Central device on the other end (such as you mobile phone using the Adafruit Bluefruit LE
Connect application for Android (https://adafru.it/f4G) or iOS (https://adafru.it/f4H) in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select bleuart_cmdmode:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library » bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 3 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library »

This will open up a new instance of the example in the IDE, as shown below:
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bleuart_cmdmode | Arduinc 1.6.4 i - E I

File Edit Sketch Tools Help

hleuart_cmdmode §

Bfile bleuart_cmdmode. ino
Fauthor hathach, ktown (Adafruit Industries)

m

Thizs demo will show you how to send and receive data in COMMAND mode | &)
(without needing to put the module into DATA mode or using the MODE pin)

"/

#include <string.h>

#include <Arduino.hs>

ginclude <5PI.h>

#include <SoftwareSerial.h>

#include "Adafruit BLE.L"
#include "Adafruit BLE_HWSFI.h"
#include "Adafruit BluefruitLE_UART.h"

/4 IE wou are using Software 3Jerial....
S/ The following macros declare the pins used for 3W serial, you should
// use these pins if you are commecting the UART Friend to |a.u jol

#define BLUEFEUIT SWUART FXD_PIN ] J// Becuired for software serial!
#define BELUEFRUIT_SWUART TxD_PIN 10 /4 Becquired for software serial!
#define BLUEFEUIT UART CTS_FPIN 11 // Required for software serial!
#define BELUEFRUIT_UART RTS_PIN -1 /4 Optional, set to -1 if unused

/¢ TE wou are using Hardware Serial
// The following macros declare the Serial port you are using. Uncomment this

P0 liamm i wmmar  manm mmsmam s damer dmlem DTE dmm T ommam el (M s man T man

4 | i | 3

Adafruit Flara on GOk

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do
not configure & connect a MODE pin

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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N
COM250 (Adafruit Flora) E=EER=C

2dafruit Bluefruit Command Mode Example -

Initialising the Bluefruit LE module: ATZ

<- Q0K
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0
0K
Requesting Bluefruit info:

m

BLEFRIEND32
nRF51822 QFRCA10
D5321F75475B198E
0.6.2

0.8.2

Epr 30 2015

5110 &.0.0, 0.2
0K

Please use Rdafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

Autoscroll jNo line ending jSEUU baud =

Once you see the request, use the App to connect to the Bluefruit LE module in UART mode so you get the text box on
your phone

Any text that you type in the box at the top of the Serial Monitor will be sent to the connected phone, and any data
sent from the phone will be displayed in the serial monitor:
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You can see the incoming string here in the Adafruit Bluefruit LE Connect app below (iOS in this case):

© Adafruit Industries

COM250 (Adafruit Flora) ol o

|

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B192E
0.68.2

0.6.2

Epr 30 2015

5110 &.0.0, 0.2
0K

Please use Rdafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

EE L L P L L )

[Send] Hello, Adafruit!

m

1

Autoscroll jNo line ending jSEUU baud
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Hello, Adafruit!

Why hello, Arduino! Send

1 1 1 1 1 11 1

€ & @

return

The response text ('Why hello, Arduino!’) can be seen below:
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COM250 (Adafruit FI_ E=EERTSC

| |[send ]

<- Q0K
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0
0K
Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALO
D5321F75475B198E
0.6.2
0.68.2
Epr 30 2015
5110 2.0.0, 0.2
0K
|| Flease use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

EEE L RS S ST T L]

[Send] Hello, Rdafruit!
[Recw] Why hello, Arduino!

~

m

[¥] Autoscrol [Noline ending  + | | 9600 baud

5
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ﬁ adafruit learning system
HIDKeyboard

The HIDKeyboard example shows you how you can use the built-in HID keyboard AT commands to send keyboard
data to any BLE-enabled Android or iOS phone, or other device that supports BLE HID peripherals.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select hidkeyboard:

Adafruit. AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified [ beacon
Adafruit_BMP183_Unified_Library » bleuart

Adafruit_ BNO055 2 factoryreset
Adafruit_CC3100 [ 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar » uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

'@ hidkeyboard | Arduino 1.6

File Edit Sketch Tools Help

hidkeyboard

vold setupivoid) -

Serial.begin(ll15200);
Serial.println(F{"ELE HID FEYEOARD EXAMPLE")):
Serial.println(F("-------—----—oooooommo o R

/* Initialise the module */
Serial.print{F("Initialising the BEluefruit LE module: "));

if | 'ble.begin() )

{
Serial.println( F("FAILED! (Check wyour wiring?)") ):
while (1) {}

}

Serial.println({ F("0E!") }:

m

/* Perform a factory reset to make sure everything is in a knowm state */
Serial.print(F("Performning a factory reset: ")); =
EXECUTE| ble.factoryReset{) ):

/% Digable command echo from Eluefruitc */
ble.echo(false);

/% Set ble command verbose */
ble.verbose (false);

J* Print Bluefruit information */
ble.infao();

4 1 | +

Arduino U
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Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode!
® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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_ -
COM250 (Adafruit Flora) E=NEERTCE
|l

[

Adafruit Bluefruit HID Keyboard Example — l

Initialising the Bluefruit LE module: I
ATZ

<- 0K

QK!

Performing a factory reset:
AT+FACTORYRESET

<- OK
ATE=0

<- RATE=0

QK

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACALQ
D5321F75475B19EE
0.6.2

0.68.2

Rpr 30 2015

5110 8.0.0, 0.2
QK

m

Setting device name to "Bluefruit Eeyboard':
AT+GAFDEVNAME=Bluefruit Keyboard

<— OK
Enable Keyboard Service:
AT+BleKeyboardEn=0n

<- 0K
Performing a 5W reset (service changes regquire a reset):
ATZ

<- 0K

Go to your phone's Bluetooth settings to pair your device
then open an application that accepts keyboard input

Enter the character(s) to send:
- \r for Enter

- \n for newline

- A\t for tab

- \b for backspace

keyboard > -

[¥] Autoscroll iNo line ending vj il:LSZI.’JU baud vi

To send keyboard data, type anything into the textbox at the top of the Serial Monitor and click the Send button.

Bonding the HID Keyboard

Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC. The bonding process establishes
a permanent connection between the two devices, meaning that as soon as your phone or PC sees the Bluefruit LE
module again it will automatically connect.
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The exact procedures for bonding the keyboard will varying from one platform to another.

When you no longer need a bond, or wish to bond the Bluefruit LE module to another device, be sure to

delete the bonding information on the phone or PC, otherwise you may not be able to connect on a new
devicel

Android

To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to the Settings application and click
the Bluetooth icon.

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The exact appearance may vary
depending on your device and OS version.

Wireless & networks

¥  WiFi ®  Bluetooth

( Datausage s« More

Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising itself as Bluefruit Keyboard
under the 'Available devices' list:

< Bluetooth

(0]}

Available devices e

R 69:CC:12:C6:2A:75
E  Bluefruit Keyboard
% 14:99:E2:05:29:CF
Nexus 7 is visible to nearby devices while Bluetooth Settings is open.
Tapping the device will start the bonding process, which should end with the Bluefruit Keyboard device being moved

to a new 'Paired devices' list with 'Connected' written underneath the device name:
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Paired devices

Bluefruit Keyboard e

Connected

To delete the bonding information, click the gear icon to the right of the device name and the click the Forget button:

Paired devices
Name

Bluefruit Keyboard

Use for

Input device

FORGET oK

i0S

To bond the keyboard on an iOS device, go to the Settings application on your phone, and click the Bluetooth menu
item.

The keyboard should appear under the OTHER DEVICES list:
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00000 Free = 15:27 7 0} .

< Settings Bluetooth

Bluetooth C

Now discoverable as “iPhone de Kevin”.

MY DEVICES

SONY:CMT-X5CD Not Connected (i)

OTHER DEVICES -,
Adafruit Bluefruit LE

To pair an Apple Watch with your iPhone, go to the Apple
Watch app.

Once the bonding process is complete the device will be moved to the MY DEVICES category, and you can start to
use the Bluefruit LE module as a keyboard:

MY DEVICES
Bluefruit Keyboard Connected @
SONY:CMT-X5CD Not Connected (i)

To unbond the device, click the 'info' icon and then select the Forget this Device option in the menu:
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{ Bluetooth Bluefruit Keyboard

OS X

Forget This Device

To bond the keyboard on an OS X device, go to the Bluetooth Preferences window and click the Pair button beside
the Bluefruit Keyboard device generated by this example sketch:

To unbond the device once it has been paired, click the small 'x' icon beside Bluefruit Keyboard:

© Adafruit Industries

Bluetooth: On
Turn Bluetooth Off

Now discoverable as

“Kevin's MacBook Pro”

Bluetooth

Devices

e Bluefruit Keyboard

Show Bluetooth in menu bar

[a

e

Pair

Advanced...

https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le
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e00 < G Blustooth [a o)
Devices 3
Bluefruit Keyboard
Connected
Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
Show Bluetooth in menu bar Advanced... ?

... and then click the Remove button when the confirmation dialogue box pops up:

Are you sure you want to remove “Bluefruit Keyboard”?

You have to pair this device again if you want to use it later.

Cancel Remove
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ﬁ adafruit learning system
Controller

The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a hand-held controller or an
external data source, taking advantage of the wealth of sensors on your phone or tablet.

You can take accelerometer or quaternion data from your phone, and push it out to your Arduino via BLE, or get the
latest GPS co-ordinates for your device without having to purchase (or power!) any external HW.

Opening the Sketch

To open the Controller sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and
select controller:

Adafruit_ AHRS
Adafruit_BluefruitLE_nRF51
Adafruit_ BMP085_Unified
Adafruit_BMP183_Unified_Library
Adafruit CC3100
Adafruit_DHT_Unified
Adafruit_DotStar

atcommand
beacon

bleuart_cmdmode
bleuart_datamode
controller
factoryreset

Adafruit_FONA_Library heartratemonitor
Adafruit_HMC5883_Unified hidkeyboard
Adafruit_L3GD20_U uribeacon

VVYVYVYVYYVYVYYVYYRAY

Adafruit_LSM303DLHC

This will open up a new instance of the example in the IDE, as shown below:
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[ N ] controller | Arduino 1.6.4

controller

/!

Bfile controller.ino

Bauthor  ladyada, ktown (Adafruit Industries)
Y
#include estring.h>
#include <Arduino.h=
#include <SPI.h>
#include <SoftwareSerial.h>

#include "Adafruit_BLE.h"
#include "Adafruit_BLE_HWSPI.h"
#include "Adafruit_BluefruitLE_UART.h"

/¢ If you are using Software Serial....
/7 The following macros declare the pins used for 5N serial, you should
i /7 use these pins if you are connecting the UART Friend to an UND

#define BLUEFRUIT_SWUART_RXD_PIN 9 /7 Required for software serial!
#define BLUEFRUIT_SWUART_TXD_PIN 1@ // Required for software serial!
#define BLUEFRUIT_UART_CTS_PIN 11 // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN -1 // Optional, set to -1 if unused

// If you are using Hardware Serial

£ The following macros declare the Serial port you are using. Uncomment this
// line if you are connecting the BLE to Leonardo/Micro or Flora

//#define BLUEFRULT_HWSERTAL_NAME Seriall

// Other recommended pins!
#define BLUEFRUIT_UART_MODE_PIN 12 // Optional but recommended, set to -1 if unused

Arduinc Uno on /dev/cu

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial will also be easier to use if you wire up the MODE pin, you can use any pin but our tutorial has pin 12
by default. You can change this to any pin. If you do not set the MODE pin then make sure you have the mode
switch in CMD mode

® |f you are using a Flora or otherwise don't want to wire up the Mode pin, set the BLUEFRUIT_UART_MODE_PIN
to -1in the configuration tab so that the sketch will use the +++ method to switch between Command and Data
mode!

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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[ NN /dev/cu.usbmodem1411131

Send
UK
0K!
Ferforming a factory reset: AT+FACTORYRESET
<- AT+FACTORYRESET
OK
ATE=8
<- ATE=8
OK
Reguesting Bluefruit info:
BLEFRIEND3Z
nRF51822 QFACALS
B7E9E922AEBC9491
8.6.2
B.6.2
Apr 3@ 2815
5119 &.8.8, 0.2
OK
Please use Adafruit Bluefruit LE app to connect in Controller mode
Then activatesuse the sensors, color picker, game controller, etc!
™ Autoscroll [ Nolineending #| | 115200 baud * |

Using Bluefruit LE Connect in Controller Mode

Once the sketch is running you can open Adafruit's Bluefruit LE Connect application (available for

Android (https://adafru.it/f4G) or iOS (https://adafru.it/f4H)) and use the Controller application to interact with the sketch.
(If you're new to Bluefruit LE Connect, have a look at our dedicated Bluefruit LE Connect learning

guide (https://adafru.it/iCm).)

On the welcome screen, select the Adafruit Bluefruit LE device from the list of BLE devices in range:

all Adafruit Bluefruit LE i st

-43  UART capable

Then from the activity list select Controller:

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 81 of 223


https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://itunes.apple.com/app/adafruit-bluefruit-le-connect/id830125974?mt=8
file:///bluefruit-le-connect-for-ios/settings

Connect to Adafruit Bluefruit LE
Choose mode:

Info

UART

Pin I/O

Controller

Cancel

This will bring up a list of data points you can send from your phone or tablet to your Bluefruit LE module, by enabling
or disabling the appropriate sensor(s).

Streaming Sensor Data

You can take Quaternion (absolute orientation), Accelerometer, Gyroscope, Magnetometer or GPS Location data from
your phone and send it directly to your Arduino from the Controller activity.

By enabling the Accelerometer field, for example, you should see accelerometer data update in the app:
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Quaternion

OFF

Accelerometer

x: 0.15683

y: -0.580338

z: -0.794373

Gyro

OFF

Magnetometer

OFF

Location

The data is parsed in the example sketch and output to the Serial Monitor as follows:

Accel 0.20
Accel 0.22
Accel 0.25
Accel 0.21
Accel 0.27

© Adafruit Industries

-0.51 -0.
-0.50 -0.
-0.51 -0.
-0.47 -0.
-0.48 -0.
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[ ] & /dev/cu.usbmodem1411131

| | Send |
Accel @.16  -8.55 -8.82
Accel ©.14  -@.53  -@.81
Accel .17 -8.52 -0.83
Accel ©.14  -@.52  -0.83
Accel @.18  -@.55 -0.78
Accel 8.18  -8.38 -0.98
Accel 8.13  -8.37  -1.81
Accel ©.16  -8.37 -0.92
Accel .24 -@.43  -0.83
Accel ©.28  -8.38  -1.03
Accel .28 -0.41  -0.93
Accel ©.17  -@.44 -0.79
Accel 8.23  -8.51 -8.84
Accel ©.28  -@.48  -0.86
Accel .21 -@.48  -0.82
Accel .28 -0.50  -0.81
Accel @.21  -@.51 -@.&7
Accel .22 -0.49  -0.84
Accel  8.28 -8.51 -8.76
Accel ©.22  -8.58 -8.83
Accel .25  -@.51 -9.83
Accel @8.21  -8.47  -8.76
Accel .27 -B.48  -0.82
™ Autoscroll | MNolineending +| | 115200 baud 3|

Note that even though we only print 2 decimal points, the values are received from the App as a full 4-byte floating
point.

Control Pad Module

You can also use the Control Pad Module to capture button presses and releases by selecting the appropriate menu
item:

Control Pad

This will bring up the Control Pad panel, shown below:
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Button presses and releases will all be logged to the Serial Monitor with the ID of the button used:

Button 8 pressed
Button 8 released
Button 3 pressed
Button 3 released

Color Picker Module

You can also send RGB color data via the Color Picker module, which presents the following color selection dialogue:
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22:38

Color Picker

R:164 G:47 B:255

This will give you Hexadecimal color data in the following format:
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RGB #A42FFF

You can combine the color picker and controller sample sketches to make color-configurable animations triggered by
buttons in the mobile app-- very handy for wearables! Download this combined sample code (configured for Feather
but easy to adapt to FLORA, BLE Micro, etc.) to get started:

https://adafru.it/kzF

https://adafru.it/kzF
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ﬁ adafruit learning system
HeartRateMonitor

The HeartRateMonitor example allows you to define a new GATT Service and associated GATT Characteristics, and
update the characteristic values using standard AT commands.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select heartratemonitor:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNO055 > factoryreset
Adafruit_CC3100 » heartratemonitor
Adafruit_ DHT_Unified > hidkeyboard
Adafruit_DotStar »> uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:
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(2o heartratemonitor | Ang

File Edit Sketch Tools Help

heartratemanitar

vold setup(vold)

{
Serial.begin(ll15200) ;
Serial.println({F{"ELE HEART PATE MONITOR (HEM) EXAMPLE™)):
Serial.println(F("------—---—---———————— R

randonSeed{micros())

J% Initialize the module */

Serial.print(F{"Initialising the Bluefruit LE module: ")) ;
if { 'ble.beginf) )
{

Serial.println{ F("FAILED! (Check your wiring?)™) ):

m

while{l){}
}
Serial.println{ F{"0E'"™) }:

J* Perform a factory reset to make sure everything iz in a knowm state */
Serial.print(F({"Perforning a factory resest: "));
EXECUTE( ble.factoryBeseti) ):

S* Disable command echo from Bluefruit */
ble.echo(false);

J* Set ble command wverbose */
bhle.wverbose (VEREOSE_MODE) ; -

Arduing

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If Using Hardware or Software UART

This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do not
configure & connect a MODE pin

This demo uses some long data transfer strings, so we recommend defining and connecting both CTS and RTS to pins,
even if you are using hardware serial.

If you are using a Flora or just dont want to connect CTS or RTS, set the pin #define's to -1 andDon't forget to also
connect the CTS pin on the Bluefruit to ground! (The Flora has this already done)

If you are using RTS and CTS, you can remove this line below, which will slow down the data transmission
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// this line is particularly required for Flora, but is a good idea
// anyways for the super long lines ahead!
ble.setInterCharWriteDelay(5); // 5 ms

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:

.
COM250 (Adafruit Flora) e )

Edafruit Bluefruit Heart Rate Monitor (HEM) Example -

Initialising the Bluefruit LE module:
ATZ

m

- OK

(O !

Performing a factory reset:
AT+FACTORYRESET 4

- 0K
RATE=0

- RATE=0
(0K
Requesting Bluefruit info:

'[BLEFRIEND32

mRF51822 QFACALQ

D5321F75475B192E

0.68.2

0.6.2

[Apr 30 2015

/5110 §.0.0, 0.2

(0K

Setting device name to '"Bluefruit HEM':
AT+GAFDEVNAME=Bluefruit HEM

i | 3

iNo line ending vj iQGOU baud
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(8 comzsn (Adarutt Fiora) MR A [ [E=R e

Setting device name to 'Bluefruitc HRM':
AT+GRPDEVNAME=Bluefruit HRM

<- OK

Adding the Heart Rate Service definition (UUID = 0x180D):
AT+GRTTADDSERVICE=UUID=0x180D

<1

<- OK

Adding the Heart Rate Measurement characteristic (UUID = 0x2A37):
AT+GRTTRADDCHAR=UUID=0x2237, FROPERTIES=0x10, MIN_LEN=2, MRX LEN=3, VALUE=00-40
<=1

<- 0K

Rkdding the Body Sensor Location characteristic (UUID = 0x2R38):
AT+GATTADDCHAR=UUID=0x2A38, PROPERTIES=0x02, MIN_LEN=1, VALUE=3

<- 2

<- OK
Adding Heart Rate Service UUID to the advertising payload: AT+HGAPSETADVDATA=02-01-06-05-02-0d-18-0a-18

<- 0K
Performing a SW reset (service changes require a reset): ATZ

<- OK

Updating HEM wvalue to 82 BEM
AT+GRTTCHAR=1,00-32

<- OK
Updating HEM wvalue to 61 BEM
AT+GRTITCHAR=1,00-3D

m

:Nc line ending v: 9600 baud

-

If you open up an application on your mobile device or laptop that support the standard Heart Rate Monitor
Service (https://adafru.it/f4l), you should be able to see the heart rate being updated in sync with the changes seen in

the Serial Monitor:

NRF Toolbox HRM Example

The image below is a screenshot from the free nRF Toolbox (https://adafru.it/e9M) application from Nordic on Android
(also available on iOS (https://adafru.it/f4J)), showing the incoming Heart Rate Monitor data:

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le

Page 91 of 223


https://developer.bluetooth.org/TechnologyOverview/Pages/HRS.aspx
https://play.google.com/store/apps/details?id=no.nordicsemi.android.nrftoolbox&hl=en
https://itunes.apple.com/app/nrf-toolbox/id820906058?mt=8

3} 9.4 = 0312

2l BLUEFRUIT HRM

Finger 55

sensor position bpm

. I

0 N SR

o

Q70

R/
\/ \
2 4 6 8 10

Time (seconds)

—s— Heart Rate

DISCONNECT

Wireless by Nordic

CoreBluetooth HRM Example

The image below is from a freely available CoreBluetooth sample application (https://adafru.it/f4K) from Apple showing
how to work with Bluetooth Low Energy services and characteristics:
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[ ] ® Heart Rate Monitor

Connected
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ﬁ adafruit learning system
UriBeacon

The UriBeacon example shows you how to use the built-in UriBeacon AT commands to configure the Bluefruit LE
module as a UriBeacon advertiser, following Google's Physical Web UriBeacon (https://adafru.it/edk) specification.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE
and select uribeacon:

Adafruit AHRS 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNO055 > factoryreset
Adafruit_CC3100 » heartratemonitor
Adafruit_ DHT_Unified > hidkeyboard
Adafruit_DotStar »> uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below. You can edit the URL that the beacon will
point to, from the default http://www.adafruit.com or just upload as is to test
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uribeacon | Arduino 1.6.4 E@g

File Edit Sketch Tools Help

uriheacon
#define BLUEFRUIT_UART TxD_ PIN (9) -
| #define ELUEFRUIT_UART CTS_FIN (10)
#define ELUEFRUIT_UART ETS_PIN (11}

//Adafruit BLE_HWSFI ble(BLUEFRUIT SPT_CS_FIN, BLUEFRUIT SFI_IRQ_FIN /*, ELUEFRUIT_SFI_EST PIN *,
Adafruit_BLE_SWUART ble (BLUEFRUIT UART RXD_PIN, BLUEFRUIT UART TXD_PIN,
BLUEFRUIT UART CTS_PIN, BLUEFRUIT UART RTS_FIN, BLUEFRUIT UART MODE PIN);

Ji==
/4 APPLICATION SETTING
Ji==
#define EUFSIZE 18

/4 URL that iz advertiszed, it must not longer than 17 j(omitted http:// and www. )
#define URL "http: /v, adafruic, com”

m

/*!
[@brief Helper MACROS to check command execution. Print 'FAILED!' or '0K!'',
loop forever if failed

*

#define EXECUTE (command)
do{" I

if | 'icommand) ) { Serial.printlnm( Fi{"FAILED'™) ); whileilj{} }*
Serial.println( F("0K!'™) )2\
Jwhile {0} '
4 m | »

Arduino U

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI.
The default is hardware SPI

If using software or hardware Serial UART:

® This tutorial does not need to use the MODE pin, make sure you have the mode switch in CMD mode if you do
not configure & connect a MODE pin

® Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it!(The Flora has this
already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished,
open up the Serial Monitor via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner
is set to 115200:
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COM250 (Adafruit

|

2dafruit Bluefruit UriBeacon Example

Initialising the Bluefruit LE module:
RTZ

<- 0K

OK!

| |Ferforming a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- ATE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRLO
D5321F75475B198E
0.6.2

0.6.2

Epr 30 2015

5110 g8.0.0, 0.2
)24

Setting uri beacon to Adafruit website: AT+BLEURIBEACON=http://www.adafruit.com
<— 0K

Please use Google Physical Webk application toc test

Autoscroll Moline ending = | | 115200 baud |

At this point you can open the Physical Web Application for Android (https://adafru.it/edi) or for
i0S (https://adafru.it/edj), and you should see a link advertising Adafruit's website:

yY [ 3 o B 16:40

Nearby Beacons :

Adafruit Industries, Unique & fun DIY electronics and kits
http://www.adafruit.com

Adafruit Industries, Unique & fun DIY electronics and kits : - Tools Gift Certificates Arduino
Cables Sensors LEDs Books Power EL Wire/Tape/Panel Components & Parts LCDs &...
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* adafruit learning system
HALP!

When using the Bluefruit Micro or a Bluefruit LE with Flora/Due/Leonardo/Micro the examples dont
run?

We add a special line to setup() to make it so the Arduino will halt until it sees you've connected over the Serial
console. This makes debugging great but makes it so you cannot run the program disconnected from a computer.

Solution? Once you are done debugging, remove these two lines from setup()
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while (!Serial);
delay(500);

[l can't seem to "Find" the Bluefruit LE!

Getting something like this?
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-
COM250 (Adafruit Flora)

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module:
ATZ

|<- ATZ

<- ATZ

<- ATZ

<- RATZ

<= Couldn't find Bluefruit, make sure it"'s in CoMmanD mode & check wiring?

Autoscroll Molineending | |9600baud |

For UART/Serial Bluefruits:

Check you have the MODE switch in CMD and the MODE pin not wired to anything if it isnt used!

If you are trying to control the MODE from your micro, make sure you set the MODE pin in the sketch

Make sure you have RXI and TXO wired right! They are often swapped by accident

Make sure CTS is tied to GND if you are using hardware serial and not using CTS

Check the MODE red LED, is it blinking? If its blinking continuously, you might be in DFU mode, power cycle the
module!

® |f you are using Hardware Serial/Software Serial make sure you know which one and have that set up

If using SPI Bluefruit:
® Make sure you have all 5 (or 6) wires connected properly.
® |f using hardware SPI, you need to make sure you're connected to the hardware SPI port, which differs
depending on the main chipset.

If using Bluefruit Micro:

® Make sure you change the RESET pin to #4 in any Config file. Also be sure you are using hardware SPI to
connect!
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ﬁ adafruit learning system
AT
Commands

The Bluefruit LE modules use aHayes AT-style command set (https://adafru.it/ebJ)to configure the device.

The advantage of an AT style command set is that it's easy to use in machine to machine communication, while still
being somewhat user friendly for humans.

Test Command Mode '=7'
'Test' mode is used to check whether or not the specified command exists on the system or not.

Certain firmware versions or configurations may or may not include a specific command, and you can determine if the
command is present by taking the command name and appending '=?' to it, as shown below

AT+BLESTARTADV="?

If the command is present, the device will reply with 'OK". If the command is not present, the device will reply
with 'ERROR".

AT+BLESTARTADV=?
0K\ r\n
AT+MISSINGCMD="?
ERROR\ r\n

Write Command Mode '=xxx'

'Write' mode is used to assign specific value(s) to the command, such as changing the radio's transmit power level
using the command we used above.

To write a value to the command, simple append an '=' sign to the command followed by any paramater(s) you wish to
write (other than a lone '?' character which will be interpretted as tet mode):

AT+BLEPOWERLEVEL=-8

If the write was successful, you will generally get an 'OK' response on a new line, as shown below:

AT+BLEPOWERLEVEL=-8
OK\r\n

If there was a problem with the command (such as an invalid parameter) you will get an'ERROR' response on a new
line, as shown below:

AT+BLEPOWERLEVEL=3
ERROR\ r\n

Note: This particular error was generated because '3' is not a valid value for the AT+BLEPOWERLEVEL command.

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 101 of 223


http://en.wikipedia.org/wiki/Hayes_command_set

Entering '-4','0' or '4" would succeed since these are all valid values for this command.

Execute Mode

'Execute' mode will cause the specific command to 'run', if possible, and will be used when the command name is
entered with no additional parameters.

AT+FACTORYRESET

You might use execute mode to perform a factory reset, for example, by executing the AT+FACTORYRESET command
as follows:

AT+FACTORYRESET
OK\ r\n

NOTE: Many commands that are means to be read will perform the same action whether they are sent to the command
parser in 'execute’ or 'read' mode. For example, the following commands will produce identical results:

AT+BLEGETPOWERLEVEL
-4\r\n

OK\r\n
AT+BLEGETPOWERLEVEL?
-4\r\n

OK\r\n

If the command doesn't support execute mode, the response will normally be 'ERROR' on a new line.
Read Command Mode "'
'Read' mode is used to read the current value of a command.

Not every command supports read mode, but you generally use this to retrieve information like the current transmit
power level for the radio by appending a '?' to the command, as shown below:

AT+BLEPOWERLEVEL?

If the command doesn't support read mode or if there was a problem with the request, you will normally get
an 'ERROR' response.

If the command read was successful, you will normally get the read results followed by 'OK' on a new line, as shown
below:

AT+BLEPOWERLEVEL?
-4\r\n
OK\r\n

Note: For simple commands, 'Read' mode and 'Execute' mode behave identically.
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ﬁ adafruit learning system
Standard
AT

The following standard Hayes/AT commands are available on Bluefruit LE modules:

AT

Acts as a ping to check if we are in command mode. If we are in command mode, we should receive the 'OK' response.
Codebase Revision: 0.3.0
Parameters: None

Output: None

AT
0K

ATI

Displays basic information about the Bluefruit module.
Codebase Revision: 0.3.0

Parameters: None

Output: Displays the following values:

Board Name

Microcontroller/Radio SoC Name

Unique Serial Number

Core Bluefruit Codebase Revision

Project Firmware Revision

Firmware Build Date

Softdevice, Softdevice Version, Bootloader Version (0.5.0+)

ATI

BLEFRIEND
nRF51822 QFAAGOO
FB462DF92A2C8656
0.5.0

0.5.0

Feb 24 2015

S110 7.1.0, 0.0
0K

Updates:
® Version 0.4.7+ of the firmware adds the chip revision after the chip name if it can be detected (ex. 'nRF51822

QFAAGO00).
® \/ersion 0.5.0+ of the firmware adds a new 7th record containing the softdevice, softdevice version and
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bootloader version (ex. 'S110 7.1.0, 0.0').

ATZ

Performs a system reset.
Codebase Revision: 0.3.0
Parameters: None

Output: None

ATZ
0K

ATE

Enables or disables echo of input characters with the AT parser
Codebase Revision: 0.3.0
Parameters: '1' = enable echo, '0' = disable echo

Output: None

# Disable echo support
ATE=0

0K

#Enable echo support
ATE=1

0K

+++

Dynamically switches between DATA and COMMAND mode without changing the physical CMD/UART select switch.

When you are in COMMAND mode, entering +++\n' or '+++\r\n' will cause the module to switch to DATA mode, and
anything typed into the console will go direct to the BLUE UART service.

To switch from DATA mode back to COMMAND mode, simply enter '+++\n' or '+++\r\n' again (be sure to include the
new line character!), and a new 'OK' response will be displayed letting you know that you are back in COMMAND
mode (see the two 'OK' entries in the sample code below).

Codebase Revision: 0.4.7

Parameters: None

Output: None

|:| Note that +++ can also be used on the mobile device to send and receive AT command on iOS or Android,

though this should always be used with care.

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le Page 104 of 223



|:| See the AT+MODESWITCHEN command to control the availability of the +++ command

ATI

BLEFRIEND
nRF51822 QFAAGOO
B122AAC33F3D2296
0.4.6

0.4.6

Dec 22 2014

0K

+++

0K

0K
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* adafruit learning system
General
Purpose

The following general purpose commands are available on all Bluefruit LE modules:

AT+FACTORYRESET

Clears any user config data from non-volatile memory and performs a factory reset before resetting the Bluefruit
module.

Codebase Revision: 0.3.0
Parameters: None

Output: None

AT+FACTORYRESET
0K

I:l As of version 0.5.0+ of the firmware, you can perform a factory reset by holding the DFU button down for 10s

until the blue CONNECTED LED lights up, and then releasing the button.

AT+DFU

Forces the module into DFU mode, allowing over the air firmware updates using a dedicated DFU app on iOS or
Android.

Codebase Revision: 0.3.0
Parameters: None

Output: None

|:| The AT parser will no longer responsd after the AT+DFU command is entered, since normal program

execution effectively halts and a full system reset is performed to start the bootloader code

AT+DFU
0K

AT+HELP

Displays a comma-separated list of all AT parser commands available on the system.
Codebase Version: 0.3.0

Parameters: None
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Output: A comma-separated list of all AT parser commands available on the system.

I:l The sample code below may not match future firmware releases and is provided for illustration purposes only

AT+HELP
AT+FACTORYRESET,AT+DFU,ATZ,ATI,ATE, AT+DBGMEMRD , AT+DBGNVMRD , AT+HWLEDPOLARITY , AT+HWLED, AT+HWGETDIETEMP, AT
+HWMODEPINPOLARITY,AT+HWMODEPIN, AT+HWGPIOMODE , AT+HWGPIO, AT+HWI2CSCAN, AT+HWADC, AT+HWVBAT , AT+HWPWM, AT+HWP
WRDN, AT+BLEPOWERLEVEL , AT+BLEGETADDRTYPE , AT+BLEGETADDR , AT+BLEBEACON, AT+BLEGETRSSI , AT+GAPGETCONN, AT+GAPDI
SCONNECT, AT+GAPDEVNAME, AT+GAPDELBONDS , AT+GAPINTERVALS, AT+GAPSTARTADV, AT+GAPSTOPADV, AT+GAPAUTOADV , AT+GAP
SETADVDATA, AT+BLEUARTTX, AT+BLEUARTRX, AT+GATTADDSERVICE, AT+GATTADDCHAR, AT+GATTCHAR, AT+GATTLIST, AT+GATTCL
EAR, AT+HELP

OK

AT+NVMWRITE

Writes data to the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:

® offset: The numeric offset for the first byte from the starting position in the user NVM
® datatype: Which can be one of STRING (1), BYTEARRAY (2) or INTEGER (3)
® data: The data to write to NVM memory (the exact payload format will change based on the specified datatype).

Output: Nothing

# Write 32768 as an integer starting at byte 16 in user NVM
AT+NVMWRITE=16, INTEGER, 32768
0K

AT+NVMREAD

Reads data from the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:
offset: The numeric offset for the first byte from the starting position in the user NVM
size: The number of bytes to read
datatype: The type used for the data being read, which is required to properly parse the data and display it as a

response. The value can be one of STRING (1), BYTEARRAY (2) or INTEGER (3)

Output: The data read back, formatted based on the datatype argument.
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# Read an integer back from position 16 in user NVM
AT+NVMREAD=16, 4, INTEGER

32768

0K

AT+MODESWITCHEN

Enables or disables mode switches via the '+++' command on the BLE peripheral of BLE UART side of the connection.
Codebase Version: 0.7.1
Parameters:
® |ocation: This can be a string, either local' or 'ble' indicating which side should have the '+++' command enabled
or disabled, 'local' being the Bluefruit peripheral and 'ble' being the phone or tablet.

® state: '0' to disable '+++' mode switches, 1' to enable them.

Output: None

|:| By default, '+++' is enabled locally, and disabled in BLE

# Disable reomte '+++' mode switches
AT+MODESWITCHEN=ble, 0
0K
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ﬁ adafruit learning system
Hardware

The following commands allow you to interact with the low level HW on the Bluefruit LE module, such as reading or
toggling the GPIO pins, performing an ADC conversion ,etc.:

AT+BAUDRATE

Changes the baud rate used by the HW UART peripheral on the nRF51822. Note that we do not recommend using
higher baudrates than 9600 because the nRF51 UART can drop characters!

Codebase Revision: 0.7.0
Parameters: Baud rate, which must be one of the following values:

1200
2400
4800
9600
14400
19200
28800
38400
57600
76800
115200
230400
250000
460800
921600
1000000

Output: The current baud rate

# Set the baud rate to 115200
AT+BAUDRATE=115200
0K

# Check the current baud rate
AT+BAUDRATE

115200

0K

AT+HWADC

Performs an ADC conversion on the specified ADC pin
Codebase Revision: 0.3.0
Parameters: The ADC channel (0..7)

Output: The results of the ADC conversion
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AT+HWADC=0
178
0K

AT+HWGETDIETEMP

Gets the temperature in degree celcius of the BLE module's die. This can be used for debug purposes (higher die
temperature generally means higher current consumption), but does not corresponds to ambient temperature and can
nto be used as a replacement for a normal temperature sensor.

Codebase Revision: 0.3.0
Parameters: None

Output: The die temperature in degrees celcius

AT+HWGETDIETEMP
32.25
0K

AT+HWGPIO

Gets or sets the value of the specified GPIO pin (depending on the pin's mode).
Codebase Revision: 0.3.0
Parameters: The parameters for this command change depending on the pin mode.

OUTPUT MODE: The following comma-separated parameters can be used when updating a pin that is set as an
output:

® Pin numbers

® Pin state, where:
0 0 =clear the pin (logic low/GND)
o 1= set the pin (logic high/VCC)

INPUT MODE: To read the current state of an input pin or a pin that has been configured as an output, enter the pin
number as a single parameter.

Output: The pin state if you are reading an input or checking the state of an input pin (meaning only 1 parameter is
supplied, the pin number), where:

® (O means the pin is logic low/GND
® 1 means the pin is logic high/VCC

|:| Trying to set the value of a pin that has not been configured as an output will produce an 'ERROR' response.

Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to
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|:| make use of a reserved pin number an 'ERROR' response will be generated.

# Set pin 14 HIGH
AT+HWGPIO=14,1
0K

# Set pin 14 LOW
AT+HWGPI0=14,0
0K

# Read the current state of pin 14
AT+HWGPIO=14

0

0K

# Try to update a pin that is not set as an output
AT+HWGPIOMODE=14,0

0K

AT+HWGPIO0=14,1

ERROR

AT+HWGPIOMODE

This will set the mode for the specified GPIO pin (input, output, etc.).

Codebase Revision: 0.3.0

Parameters: This command one or two values (comma-separated in the case of two parameters being used):
® The pin number

® The new GPIO mode, where:

0 =Input

1= Output

2 = Input with pullup enabled

3 = Input with pulldown enabled

O O O ©°o

Output: If a single parameters is passed (the GPIO pin number) the current pin mode will be returned.

Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to

make use of a reserved pin number an 'ERROR' response will be generated.

# Configure pin 14 as an output
AT+HWGPIOMODE=14,0
0K

# Get the current mode for pin 14
AT+HWPGIOMODE=14

0

0K

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 111 of 223



AT+HWI2CSCAN

Scans the 12C bus to try to detect any connected 12C devices, and returns the address of devices that were found
during the scan process.

Codebase Revision: 0.3.0
Parameters: None

Output: A comma-separated list of any |12C address that were found while scanning the valid address range on the 12C
bus, or nothing is no devices were found.

# I2C scan with two devices detected
AT+HWI2CSCAN

0x23,0x35

0K

# I2C scan with no devices detected
AT+HWI2CSCAN
0K

AT+HWVBAT

Returns the main power supply voltage level in millivolts
Codebase Revision: 0.3.0
Parameters: None

Output: The VBAT level in millivolts

AT+HWVBAT
3248
0K

AT+HWRANDOM

Generates a random 32-bit number using the HW random number generator on the nRF51822 (based on white noise).
Codebase Revision: 0.4.7
Parameters: None

Output: A random 32-bit hexadecimal value (ex. '0x12345678')

AT+HWRANDOM
0x769ED823
0K

AT+HWMODELED
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Allows you to override the default behaviour of the MODE led (which indicates the operating mode by default).
Codebase Revision: 0.6.6
Parameters: LED operating mode, which can be one of the following values:

disable or DISABLE or O - Disable the MODE LED entirely to save power

mode or MODE or 1 - Default behaviour, indicates the current operating mode

hwuart or HWUART or 2 - Toggles the LED on any activity on the HW UART bus (TX or RX)

bleuart or BLEUART or 3 - Toggles the LED on any activity on the BLE UART Service (TX or RX characteristic)
spi or SPI or 4 - Toggles the LED on any SPI activity

manual or MANUAL or 5 - Manually sets the state of the MODE LED via a second comma-separated parameter,
which can be on, off, or toggle.

Output: If run with no parameters, returns an upper-case string representing the current MODE LED operating mode
from the fields above

# Get the curent MODE LED setting
AT+HWMODELED

MODE

0K

# Change the MODE LED to indicate BLE UART activity
AT+HWMODELED=BLEUART

0K

# Manually toggle the MODE LED

AT+HWMODELED=MANUAL , TOGGLE
0K

AT+UARTFLOW

Enables or disable hardware flow control (CTS + RTS) on the UART peripheral block of the nRF51822.
Codebase Revision: 0.7.0
Parameters: HW flow control state, which can be one of:

on
off
0

1

Output: If run with no parameters, returns a number representing whether flow control is enabled (1) or disabled (0).
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# Check the current flow control state

AT+UARTFLOW
1
0K

# Disable HW flow control

AT+UARTFLOW=0ff
0K
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* adafruit learning system
Beacon

Adafruit's Bluefruit LE modules currently support the following 'Beacon' technologies:

® Beacon (Apple) via AT+BLEBEACON
® UriBeacon (Google) via AT+BLEURIBEACON (deprecated)
® Eddystone (Google) via AT+EDDYSTONE*

Modules can be configured to act as 'Beacons' using the following commands:

AT+BLEBEACON

Codebase Revision: 0.3.0
Parameters: The following comma-separated parameters are required to enable beacon mode:

Bluetooth Manufacturer ID (uint16_t)
128-bit UUID

Major Value (uint16_t)

Minor Value (uint16_t)

RSSI @ 1m (int8_t)

Output: None

# Enable Apple iBeacon emulation

# Manufacturer ID = 0x004C
AT+BLEBEACON=0x004C,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000, -59
0K

# Reset to change the advertising data

ATZ

0K

# Enable Nordic Beacon emulation

# Manufacturer ID = 0x0059
AT+BLEBEACON=0x0059,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000, -59
0K

# Reset to change the advertising data

ATZ

0K

AT+BLEBEACON will cause the beacon data to be stored in non-volatile config memory on the Bluefruit LE

module, and these values will be persisted across system resets and power cycles. To remove or clear the
beacon data you need to enter the 'AT+FACTORYRESET' command in command mode.

Entering Nordic Beacon emulation using the sample code above, you can see the simulated beacon in Nordic's
'Beacon Config' tool below:

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 115 of 223



[ co 2 [l *d @ 01:29

(}N Beacon config

nRF Beacon
IDENTITY
UuiD 01122334-4556-6778-899a-abbccddeeffO
MAJOR 0]
MINOR 0
NOTIFY
EVENT Near [}
ACTION Show Mona Lisa [l
STATUS
ENABLED Ooul

Wireless by Nordic

AT+BLEURIBEACON

Converts the specified URI into a UriBeacon (https://adafru.it/edk) advertising packet, and configures the module to
advertise as a UriBeacon (part of Google's Physical Web (https://adafru.it/ehZ) project).

To view the UriBeacon URIs you can use one of the following mobile applications:
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® Android 4.3+: Physical Web (https://adafru.it/edi) on the Google Play Store
® OS: Physical Web (https://adafru.it/edj) in Apple's App Store

Codebase Revision: 0.4.7
Parameters: The URI to encode (ex. http://www.adafruit.com/blog (https://adafru.it/ei0))

Output: None of a valid URI was entered (length is acceptable, etc.).

AT+BLEURIBEACON=http://www.adafruit.com/blog
0K

# Reset to change the advertising data
ATZ
0K

If the supplied URI is too long you will get the following output:

AT+BLEURIBEACON=http://www.adafruit.com/this/uri/is/too/long
URL is too long
ERROR

D If the URI that you are trying to encode is too long, try using a shortening service like bit.ly, and encode the

shortened URI.

UriBeacon should be considered deprecated as a standard, and EddyStone should be used for any future
development. No further development will happen in the Bluefruit LE firmware around UriBeacon.

Deprecated: AT+EDDYSTONEENABLE

This command will enable Eddystone (https://adafru.it/fSA) support on the Bluefruit LE module. Eddystone support must
be enabled before the other related commands can be used.

Codebase Revision: 0.6.6
Parameters: 1 or O (1= enable, O = disable)

Output: The current state of Eddystone support if no parameters are provided (1= enabled, O = disabled)

|:| This command was removed in firmware 0.7.0 to avoid confusion. Use AT+EDDYSTONESERVICEEN in 0.7.0

and higher.
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# Enable Eddystone support
AT+EDDYSTONEENABLE=1
0K

# Check the current Eddystone status on the module
AT+EDDYSTONEENABLE

1

0K

AT+EDDYSTONEURL

This command will set the URL for the Eddystone-URL (https://adafru.it/fSB) protocol.
Codebase Revision: 0.6.6
Parameters:

® The URL to encode (mandatory)

® An optional second parameter indicates whether to continue advertising the Eddystone URL even when the
peripheral is connected to a central device

® Firmware 0.6.7 added an optional third parameter for the RSSI at O meters value. This should be measured by the
end user by checking the RSSI value on the receiving device at 1m and then adding 41 to that value (to
compensate for the signal strength loss over 1m), so an RSSI of -62 at 1m would mean that you should enter -21 as
the RSSI at Om. Default value is -18dBm.

Output: Firmware <= 0.6.6: none. With firmware >=0.6.7 running this command with no parameters will return the
current URL.

# Set the Eddystone URL to adafruit
AT+EDDYSTONEURL=http://www.adafruit.com

0K

# Set the Eddystone URL to adafruit and advertise it even when connected

AT+EDDYSTONEURL=http://www.adafruit.com,1
0K

AT+EDDYSTONECONFIGEN

This command causes the Bluefruit LE module to enable the Eddystone URL config service for the specified number of
seconds.

This command should be used in combination with the Physical Web application from Google, available for

Android (https://adafru.it/edi) or iOS (https://adafru.it/edj). Run this command then select the 'Edit URL' option from the
app to change the destination URL over the air.

Codebase Revision: 0.6.6

Parameters: The number of seconds to advertised the config service UUID

Output: None

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le Page 118 of 223


https://github.com/google/eddystone/tree/master/eddystone-url
https://play.google.com/store/apps/details?id=physical_web.org.physicalweb
https://itunes.apple.com/us/app/physical-web/id927653608?mt=8

# Start advertising the Eddystone config service for 5 minutes (300s)
AT+EDDYSTONECONFIGEN=300
0K

AT+EDDYSTONESERVICEEN

Adds or removes the Eddystone service from the GATT table (requires a reset to take effect).

Codebase Revision: 0.7.0

Parameters: Whether or not the Eddystone service should be enabled or not, using on of the following values:
® on
® off
e

L N0]

Output: If the command is executed with no parameters it will disable a numeric value indicating whether the service is
enabled (1) or disabled (0).

D You must perform a system reset for this command to take effect.

# Enable Eddystone service
AT+EddyStonServiceEn=on
0K

AT+EddyStonServiceEn=1
0K

# Disable Eddystone service
AT+EddyStonServiceEn=o0ff
0K

AT+EddyStonServiceEn=0
0K

AT+EDDYSTONEBROADCAST

This command can be used to start of stop advertising the Eddystone payload using the URL stored in non-volatile
memory (NVM).

Codebase Revision: 0.7.0

Parameters: Whether or not the payload should be broadcast, using one of the following values:
on

off

1
0

Output: If executed with no parameters, the current broadcast state will be displayed as a numeric value.
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# Enable broadcasting current setting of EddyStone (stored previously on nvm)
AT+EddyStoneBroadcast=on
0K

AT+EddyStoneBroadcast=1
0K

# Disable broadcasting current setting of EddyStone (still stored on nvm)
AT+EddyStoneBroadcast=off
0K

AT+EddyStoneBroadcast=0
0K
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* adafruit learning system
BLE
Generic

The following general purpose BLE commands are available on Bluefruit LE modules:

AT+BLEPOWERLEVEL

Gets or sets the current transmit power level for the module's radio (higher transmit power equals better range, lower
transmit power equals better battery life).

Codebase Revision: 0.3.0

Parameters: The TX power level (in dBm), which can be one of the following values (from lowest to higher transmit
power):

e 6 6 o o o o o
1
00

Output: The current transmit power level (in dBm)

|:| The updated power level will take affect as soon as the command is entered. If the device isn't connected to

another device, advertising will stop momentarily and then restart once the new power level has taken affect.

# Get the current TX power level (in dBm)
AT+BLEPOWERLEVEL

0

0K

# Set the TX power level to 4dBm (maximum value)
AT+BLEPOWERLEVEL=4

0K

# Set the TX power level to -12dBm (better battery life)
AT+BLEPOWERLEVEL=-12

0K

# Set the TX power level to an invalid value

AT+BLEPOWERLEVEL=-3
ERROR

AT+BLEGETADDRTYPE

Gets the address type (for the 48-bit BLE device address).
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Normally this will be '1' (random), which means that the module uses a 48-bit address that was randomly generated
during the manufacturing process and written to the die by the manufacturer.

Random does not mean that the device address is randomly generated every time, only that a one-time random
number is used.

Codebase Revision: 0.3.0
Parameters: None
Output: The address type, which can be one of the following values:

® (= public
® 1=random

AT+BLEGETADDRTYPE
1
0K

AT+BLEGETADDR

Gets the 48-bit BLE device address.
Codebase Revision: 0.3.0
Parameters: None

Output: The 48-bit BLE device address in the following format: 'AA:BB:CC:DD:EE:FF'

AT+BLEGETADDR
E4:C6:C7:31:95:11
0K

AT+BLEGETPEERADDR

Gets the 48-bit address of the peer (central) device we are connected to.
Codebase Revision: 0.6.5
Parameters: None

Output: The 48-bit address of the connected central device in hex format. The command will return ERROR if we are
not connected to a central device.

Please note that the address returned by the central device is almost always a random value that will change

over time, and this value should generally not be trusted. This command is provided for certain edge cases,
but is not useful in most day to day scenarios.
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AT+BLEGETPEERADDR
48:B2:26:E6:C1:1D
0K

AT+BLEGETRSSI

Gets the RSSI value (Received Signal Strength Indicator), which can be used to estimate the reliability of data
transmission between two devices (the lower the number the better).

Codebase Revision: 0.3.0
Parameters: None

Output: The RSSI level (in dBm) if we are connected to a device, otherwise '0'

# Connected to an external device
AT+BLEGETRSSI

-46

0K

# Not connected to an external device
AT+BLEGETRSSI

0

0K
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* adafruit learning system
BLE Services

The following commands allow you to interact with various GATT services present on Bluefruit LE modules when
running in Command Mode.

AT+BLEUARTTX

This command will transmit the specified text message out via the UART Service (https://adafru.it/iCn) while you are
running in Command Mode.

Codebase Revision: 0.3.0

Parameters: The message payload to transmit. The payload can be up to 240 characters (since AT command strings
are limited to a maximum of 256 bytes total).

Output: This command will produce an ERROR message if you are not connected to a central device, or if the internal
TX FIFO on the Bluefruit LE module is full.

As of firmware release 0.6.2 and higher, AT+BLEUARTTX can accept a limited set of escape code sequences:

\r = carriage return
\n = new line

\t = tab

\b = backspace

\\ = backward slash

As of firmware release 0.6.7 and higher, AT+BLEUARTTX can accept the following escape code sequence since
AT+BLEUARTTX=? has a specific meaning to the AT parser:

® \? =transmits a single question mark
As of firmware release 0.7.6 and higher, AT+BLEUARTTX can accept the following escape code sequence:

® \+=transmit a single '+' character without having to worry about +++ mode switch combinations

ESCAPE SEQUENCE NOTE: If you are trying to send escape sequences in code via something like

'ble.print("...");' please note that you will need to send a double back-slash for the escape code to arrive as-
intended in the AT command. For example: ble.printin("AT+BLEUARTTX=Some Test\\r\\n");

I:l You must be connected to another device for this command to execute

# Send a string when connected to another device
AT+BLEUARTTX=THIS IS A TEST
0K

# Send a string when not connected

AT+BLEUARTTX=THIS IS A TEST
ERROR
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TX FIFO Buffer Handling

Starting with firmware version 0.6.7, when the TX FIFO buffer is full a 200ms blocking delay will be used to see if any
free space becomes available in the FIFO before returning ERROR. The exact process is detailed in the flow chart
below:

BLEUARTTX FIFO HANDLER

Collect Data
AT+BLEUARTTX=DATA

: Is the TX FIFO
peripheral full?

connected?

s
Is the TX FIFO
full?

it up t
200m: for FIFO
space

Add ‘DATA’ to TX FIFO

Note: The TX FIFO full check will happen for each GATT transaction (of up to 20 bytes of data each), so large
data transfers may have multiple 200ms wait states.

You can use the AT+BLEUARTFIFO=TX (https://adafru.it/id3) command to check the size of the TX FIFO before sending
data to ensure that you have enough free space available in the buffer.

The TX FIFO has the following size, depending on the firmware version used:

® Firmware <=0.6.6: 160 characters wide
® Firmware >=0.6.7: 1024 characters wide

It IS possible with large data transfers that part of the payload can be transmitted, and the command can still
produce an ERROR if the FIFO doesn't empty in time in the middle of the payload transfer (since data is
transmitted in maximum 20 byte chunks). If you need to ensure reliable data transfer, you should always

check the TX FIFO size before sending data, which you can do using the AT+BLEUARTFIFO command. If not
enough space is available for the entire payload, add a SW delay until enough space is available. Any single
AT+BLEUARTTX command can fit into the FIFO, but multiple large instances of this command may cause the
FIFO to fill up mid transfer.

AT+BLEUARTTXF

This is a convenience function the serves the same purpose as AT+BLEUARTTX, but data is immediately sent in a
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single BLE packet ('F' for force packet). This command will accept a maximum of 20 characters, which is the limit of
what can be send in a single packet.

Codebase Revision: 0.7.6
Parameters: See AT+BLEUARTTX

Output: See AT+BLEUARTTX

AT+BLEUARTRX

This command will dump the UART service (https://adafru.it/iCn)'s RX buffer to the display if any data has been received
from from the UART service while running in Command Mode. The data will be removed from the buffer once it is
displayed using this command.

Any characters left in the buffer when switching back to Data Mode will cause the buffered characters to be displayed
as soon as the mode switch is complete (within the limits of available buffer space, which is 1024 bytes on current black
32KB SRAM devices, or 160 bytes for the blue first generation BLEFriend board based on 16KB SRAM parts).

Codebase Revision: 0.3.0
Parameters: None

Output: The RX buffer's content if any data is available, otherwise nothing.

|:| You can also use the AT+BLEUARTFIFO=RX command to check if any incoming data is available or not.

# Command results when data is available
AT+BLEUARTRX

Sent from Android

0K

# Command results when no data is available

AT+BLEUARTRX
0K

AT+BLEUARTFIFO

This command will return the free space available in the BLE UART TX and RX FIFOs. If you are transmitting large
chunks of data, you may want to check if you have enough free space in the TX FIFO before sending, keeping in mind
that individual GATT packets can contain up to 20 user bytes each.

Codebase Revision: 0.6.7
Parameters: Running this command with no parameters will return two comma-separated values indicating the free
space in the TX buffer, following by the RX buffer. To request a specific buffer, you can execute the command with

either a "TX" or "RX" value (For example: "AT+BLEUARTFIFO=TX").

Output: The free space remaining in the TX and RX FIFO buffer if no parameter is present, otherwise the free space
remaining in the specified FIFO buffer.
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AT+BLEUARTFIFO
1024,1024
0K

AT+BLEUARTFIFO=TX
1024
0K

AT+BLEUARTFIFO=RX

1024
0K

AT+BLEKEYBOARDEN

This command will enable GATT over HID (GoH) keyboard support, which allows you to emulate a keyboard on
supported iOS and Android devices. By default HID keyboard support is disabled, so you need to set
BLEKEYBOARDEN to 1 and then perform a system reset before the keyboard will be enumerated and appear in the
Bluetooth preferences on your phone, where if can be bonded as a BLE keyboard.

Codebase Revision: 0.5.0

Parameters: 1 or O (1= enable, O = disable)

Output: None

|:| As of firmware version 0.6.6 this command is now an alias for AT+BLEHIDEN

|:| You must perform a system reset (ATZ) before the changes take effect!

Before you can use your HID over GATT keyboard, you will need to bond your mobile device with the
Bluefruit LE module in the Bluetooth preferences panel.

# Enable BLE keyboard support then reset
AT+BLEKEYBOARDEN=1

0K

ATZ

0K

# Disable BLE keyboard support then reset
AT+BLEKEYBOARDEN=0
0K

ATZ
0K

AT+BLEKEYBOARD

Sends text data over the BLE keyboard interface (if it has previously been enabled via AT+BLEKEYBOARDEN).
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Any valid alpha-numeric character can be sent, and the following escape sequences are also supported:

\r - Carriage Return
\n - Line Feed

\b - Backspace

\t - Tab

\\ - Backslash

As of version 0.6.7 you can also use the following escape code when sending a single character
('AT+BLEKEYBOARD=?" has another meaning for the AT parser):

® \? - Question mark
Codebase Revision: 0.5.0
Parameters: The text string (optionally including escape characters) to transmit

Output: None

# Send a URI with a new line ending to execute in Chrome, etc.
AT+BLEKEYBOARD=http://www.adafruit.com\r\n
0K

# Send a single question mark (special use case, 0.6.7+)
AT+BLEKEYBOARD=\?
0K

AT+BLEKEYBOARDCODE

Sends a raw hex sequence of USB HID keycodes to the BLE keyboard interface including key modifiers and up to six
alpha-numeric characters.

This command accepts the following string-encoded byte array payload, matching the way HID over GATT sends
keyboard data:

Byte 0: Modifier

Byte 1: Reserved (should always be 00)

Bytes 2..7: Hexadecimal value(s) corresponding to the HID keys (if no character is used you can enter '00' or
leave trailing characters empty)

After a keycode sequence is sent with the AT+BLEKEYBOARDCODE command, you must send a second
AT+BLEKEYBOARDCODE command with at least two 00 characters to indicate the keys were released!

Modifier Values

The modifier byte can have one or more of the following bits set:

Bit O (0x01): Left Control
Bit 1 (0x02): Left Shift

Bit 2 (0x04): Left Alt

Bit 3 (0x08): Left Window
Bit 4 (0x10): Right Control
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® Bit 5 (0x20): Right Shift
® Bit 6 (0x40): Right Alt
® Bit 7 (0x80): Right Window

Codebase Revision: 0.5.0

Parameters: A set of hexadecimal values separated by a hyphen (-'). Note that these are HID scan code values, not
standard ASCII values!

Output: None

HID Keyboard Codes

A list of hexademical-format HID keyboard codes can be found here (https://adafru.it/cQV) (see section 7), and are
listed below for convenience sake:

HID key code values don't correspond to ASCII key codes! For example, 'a' has an HID keycode value of '04',

and there is no keycode for an upper case 'A' since you use the modifier to set upper case values. For
details, google 'usb hid keyboard scan codes', and see the example below.

0x00 Reserved (no event indicated)
0x01 Keyboard ErrorRollOver

0x02 Keyboard POSTFail

0x03 Keyboard ErrorUndefined

0x04 Keyboard a and A

0x05 Keyboard b and

and
and

0x21 Keyboard
0x22 Keyboard

B

0x06 Keyboard c and C
0x07 Keyboard d and D
0x08 Keyboard e and E
0x09 Keyboard f and F
Ox0A Keyboard g and G
0x0B Keyboard h and H
0x0C Keyboard i and I
0x0D Keyboard j and J
OXOE Keyboard k and K
Ox0OF Keyboard 1 and L
0x10 Keyboard m and M
0x11 Keyboard n and N
0x12 Keyboard o and 0
0x13 Keyboard p and P
0x14 Keyboard g and Q
0x15 Keyboard r and R
0x16 Keyboard s and S
0x17 Keyboard t and T
0x18 Keyboard u and U
0x19 Keyboard v and V
0x1A Keyboard w and W
0x1B Keyboard x and X
0x1C Keyboard y and Y
0x1D Keyboard z and Z
Ox1E Keyboard 1 and !
Ox1F Keyboard 2 and @
0x20 Keyboard 3 and #
4 $

5 %
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0x23 Keyboard 6 and ©
0x24 Keyboard 7 and &
0x25 Keyboard 8 and *
0x26 Keyboard 9 and (
0x27 Keyboard 0 and )

0x28 Keyboard Return (ENTER)
0x29 Keyboard ESCAPE
Ox2A Keyboard DELETE (Backspace)
0x2B Keyboard Tab
0x2C Keyboard Spacebar
0x2D Keyboard - and (underscore)
Ox2E Keyboard = and +
0x2F Keyboard [ and {
0x30 Keyboard ] and }
0x31 Keyboard \ and |
0x32 Keyboard Non-US # and ~
0x33 Keyboard ; and :
0x34 Keyboard ' and "
0x35 Keyboard Grave Accent and Tilde
0x36 Keyboard, and <
0x37 Keyboard . and >
0x38 Keyboard / and ?
0x39 Keyboard Caps Lock
0x3A Keyboard F1
0x3B Keyboard F2
0x3C Keyboard F3
0x3D Keyboard F4
Ox3E Keyboard F5
0x3F Keyboard F6
0x40 Keyboard F7
0x41 Keyboard F8
0x42 Keyboard F9
0x43 Keyboard F10
0x44 Keyboard F11
0x45 Keyboard F12
0x46 Keyboard PrintScreen
0x47 Keyboard Scroll Lock
0x48 Keyboard Pause
0x49 Keyboard Insert
0x4A Keyboard Home
0x4B Keyboard PageUp
0x4C Keyboard Delete Forward
0x4D Keyboard End
Ox4E Keyboard PageDown
Ox4F Keyboard RightArrow
0x50 Keyboard LeftArrow
0x51 Keyboard DownArrow
0x52 Keyboard UpArrow
0x53 Keypad Num Lock and Clear
0x54 Keypad /
0x55 Keypad *
0x56 Keypad -
0x57 Keypad +
0x58 Keypad ENTER
0x59 Keypad 1 and End
Ox5A Keypad 2 and Down Arrow
0x5B Keypad 3 and PageDn
0x5C Keypad 4 and Left Arrow
0x5D Keypad 5
A

AvRF Koaunad and Rinht Arrnw
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UAUL nuypuu U Uy ey nnuw
Ox5F Keypad 7 and Home

0x60 Keypad 8 and Up Arrow
0x61 Keypad 9 and PagelUp

0x62 Keypad 0 and Insert

0x63 Keypad . and Delete
0x64 Keyboard Non-US \ and |
0x65 Keyboard Application
0x66 Keyboard Power

0x67 Keypad =

0x68 Keyboard F13

0x69 Keyboard F14

Ox6A Keyboard F15

0x6B Keyboard F16

0x6C Keyboard F17

0x6D Keyboard F18

Ox6E Keyboard F19

Ox6F Keyboard F20

0x70 Keyboard F21

0x71 Keyboard F22

0x72 Keyboard F23

0x73 Keyboard F24

0x74 Keyboard Execute

0x75 Keyboard Help

0x76 Keyboard Menu

0x77 Keyboard Select

0x78 Keyboard Stop

0x79 Keyboard Again

0x7A Keyboard Undo

0x7B Keyboard Cut

0x7C Keyboard Copy

0x7D Keyboard Paste

Ox7E Keyboard Find

Ox7F Keyboard Mute

0x80 Keyboard Volume Up

0x81 Keyboard Volume Down
0x82 Keyboard Locking Caps Lock
0x83 Keyboard Locking Num Lock
0x84 Keyboard Locking Scroll Lock
0x85 Keypad Comma

0x86 Keypad Equal Sign

0x87 Keyboard Internationall
0x88 Keyboard International2
0x89 Keyboard International3
Ox8A Keyboard International4
0x8B Keyboard International5
0x8C Keyboard International6
0x8D Keyboard International7?
Ox8E Keyboard International8
Ox8F Keyboard International9
0x90 Keyboard LANG1

0x91 Keyboard LANG2

0x92 Keyboard LANG3

0x93 Keyboard LANG4

0x94 Keyboard LANG5

0x95 Keyboard LANG6

0x96 Keyboard LANG7

0x97 Keyboard LANG8

0x98 Keyboard LANG9

0x99 Keyboard Alternate Erase
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0x9A Keyboard SysReq/Attention
0x9B Keyboard Cancel

0x9C Keyboard Clear

0x9D Keyboard Prior

Ox9E Keyboard Return

0x9F Keyboard Separator
OxAO Keyboard Out

OxAl Keyboard Oper

0xA2 Keyboard Clear/Again
OxA3 Keyboard CrSel/Props
0xA4 Keyboard ExSel

OXE® Keyboard LeftControl
OxE1l Keyboard LeftShift
OxE2 Keyboard LeftAlt

OxE3 Keyboard Left GUI
OxE4 Keyboard RightControl
OXE5 Keyboard RightShift
OxE6 Keyboard RightAlt
OXE7 Keyboard Right GUI

The following example shows how you can use this command:

# send 'abc' with left shift key (0x02) --> 'ABC'
AT+BLEKEYBOARDCODE=02-00-04-05-06-00-00

0K

# Indicate that the keys were released (mandatory!)
AT+BLEKEYBOARDCODE=00-00

0K

AT+BLEHIDEN

This command will enable GATT over HID (GoH) support, which allows you to emulate a keyboard, mouse or media
controll on supported iOS, Android, OSX and Windows 10 devices. By default HID support is disabled, so you need to
set BLEHIDEN to 1 and then perform a system reset before the HID devices will be enumerated and appear in on your
central device.

Codebase Revision: 0.6.6
Parameters: 1 or O (1= enable, O = disable)

Output: None

You normally need to 'bond' the Bluefruit LE peripheral to use the HID commands, and the exact bonding
process will change from one operating system to another.

If you have previously bonded to a device and need to clear the bond, you can run the AT+FACTORYRESET
command which will erase all stored bond data on the Bluefruit LE module.
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# Enable GATT over HID support on the Bluefruit LE module
AT+BLEHIDEN=1
0K

# Reset so that the changes take effect

ATZ
0K

AT+BLEHIDMOUSEMOVE

Moves the HID mouse or scroll wheen position the specified number of ticks.

All parameters are signed 8-bit values (-128 to +127). Positive values move to the right or down, and origin is the top
left corner.

Codebase Revision: 0.6.6
Parameters: X Ticks (+/-), Y Ticks (+/-), Scroll Wheel (+/-), Pan Wheel (+/-)

Output: None

# Move the mouse 100 ticks right and 100 ticks down
AT+BLEHIDMOUSEMOVE=100, 100
0K

# Scroll down 20 pixels or lines (depending on context)
AT+BLEHIDMOUSEMOVE=, , 20,
0K

# Pan (horizontal scroll) to the right (exact behaviour depends on 0S)
AT+BLEHIDMOUSEMOVE=0,0,0,100

AT+BLEHIDMOUSEBUTTON

Manipulates the HID mouse buttons via the specific string(s).
Codebase Revision: 0.6.6

Parameters: Button Mask String [LIRIMIB][F], Action [PRESS][CLICK][DOUBLECLICK[HOLD]

L = Left Button

R = Right Button

M = Middle Button

B = Back Button

F = Forward Button

If the second parameter (Action) is "HOLD", an optional third parameter can be passed specifying how long the
button should be held in milliseconds.

[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
Output: None
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# Double click the left mouse button
AT+BLEHIDMOUSEBUTTON=L,doubleclick
0K

# Press the left mouse button down, move the mouse, then release L
# This is required to perform 'drag' then stop type operations
AT+BLEHIDMOUSEBUTTON=L

0K
AT+BLEHIDMOUSEMOVE=-100,50
0K

AT+BLEHIDMOUSEBUTTON=0

0K

# Hold the backward mouse button for 200 milliseconds (0S dependent)

AT+BLEHIDMOUSEBUTTON=B, hold, 200
0K

AT+BLEHIDCONTROLKEY

Sends HID media control commands for the bonded device (adjust volume, screen brightness, song selection, etc.).

Codebase Revision: 0.6.6

Parameters: The HID control key to send, followed by an optional delay in ms to hold the button

The control key string can be one of the following values:

® System Controls (works on most systems)

© BRIGHTNESS+
o BRIGHTNESS-

® Media Controls (works on most systems)

PLAYPAUSE
MEDIANEXT
MEDIAPREVIOUS
MEDIASTOP

O O O O

® Sound Controls (works on most systems)

VOLUME
MUTE
BASS
TREBLE
BASS_BOOST
VOLUME+
VOLUME-
BASS+
BASS-
TREBLE+
TREBLE-

O 0O 0O 0O 0O 0O 0O 0o 0o o o

® Application Launchers (Windows 10 only so far)

© EMAILREADER

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-mO0-bluefruit-le

Page 134 of 223



o CALCULATOR
o FILEBROWSER

® Browser/File Explorer Controls (Firefox on Windows/Android only)

SEARCH
HOME

BACK
FORWARD
STOP
REFRESH
BOOKMARKS

O O 0O 0O 0O O o

You can also send a raw 16-bit hexadecimal value in the 'OXxABCD' format. A full list of 16-bit 'HID Consumer Control
Key Codes' can be found here (https://adafru.it/cQV)(see section 12).

Output: Normally none.

I:l If you are not bonded and connected to a central device, this command will return ERROR. Make sure you

are connected and HID support is enabled before running these commands.

# Toggle the sound on the bonded central device
AT+BLEHIDCONTROLKEY=MUTE
0K

# Hold the VOLUME+ key for 500ms
AT+BLEHIDCONTROLKEY=VOLUME+, 500
0K

# Send a raw 16-bit Consumer Key Code (0x006F = Brightness+)

AT+BLEHIDCONTROLKEY=0x006F
0K

AT+BLEHIDGAMEPADEN

Enables HID gamepad support in the HID service. By default the gamepad is disabled as of version 0.7.6 of the
firmware since it causes problems on iOS and OS X and should only be used on Android and Windows based devices.

Codebase Revision: 0.7.6

Parameters: Whether the gamepad service should be enabled via one of the following values:
on

off

1
0

Output: If executed with no parameters, a numeric value will be returned indicating whether the battery service is
enabled (1) or disabled (0).

|:| This command requires a system reset to take effect.
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AT+BLEHIDGAMEPAD

Sends a specific HID gamepad payload out over BLE

Codebase Revision: 0.7.0

Parameters: The following comma-separated parameters are available:

® x: LEFT, RIGHT: If X=-1then 'LEFT' is pressed, if X=1then 'RIGHT' is pressed, if X=0 then neither left nor right are
pressed

® y: UP, DOWN: If Y=-1then 'UP'is pressed, if Y=1then 'DOWN' is pressed, if Y=0 then neither up nor down are
pressed

® buttons: 0xO0-OxFF, which is a bit mask for 8 button 0-7

Output: Nothing

HID gamepad is disabled by default as of version 0.7.6, and must first be enabled via
AT+BLEHIDGAMEPADEN=1 before it can be used.

Note: You need to send both 'press' and 'release' events for each button, otherwise the system will think that
|:| the button is still pressed until a release state is received.

# Press 'RIGHT' and 'Button@' at the same time
AT+BLEHIDGAMEPAD=1,0,0x01

# Press 'UP' and 'Buttonl' + 'Button@' at the same time
AT+BLEHIDGAMEPAD=0, -1,0x03

AT+BLEMIDIEN

Enables or disables the BLE MIDI service.
Codebase Revision: 0.7.0
Parameters: State, which can be one of:

on
off
0

1

Output: If executed with no parameters, it will return the current state of the MIDI service as an integer indicating if it is
enabled (1) or disabled (0).

|:| Note: This command will require a reset to take effect.
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# Check the current state of the MIDI service
AT+BLEMIDIEN

1

0K

# Enable the MIDI Service

AT+BLEMIDIEN=1
0K

AT+BLEMIDIRX

Reads an incoming MIDI character array from the buffer.
Codebase Revision: 0.7.0
Parameters: None

Output: The midi event in byte array format

AT+BLEMIDIRX
90-3C-7F
0K

AT+BLEMIDITX

Sends a MIDI event to host.
Codebase Revision: 0.7.0
Parameters: The MIDI event in hex array format, which can be either:

® A series of full MIDI events (up to 4 events)
® Exactly 1full MIDI event + several running events without status (up to 7)

Output: None

# Send 1 event (middle C with max velocity)
AT+BLEMIDITX=90-3C-7F
0K

# Send 2 events
AT+BLEMIDITX=90-3C-7F-A0-3C-7F

0K

# Send 1 full event + running event

AT+BLEMIDITX=90-3C-7F-3C-7F
0K

AT+BLEBATTEN

Enables the Battery Service following the definition from the Bluetooth SIG.
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Codebase Revision: 0.7.0
Parameters: Whether the battery service should be enabled, via on of the following values:

® on
® Off
o 1
e 0

Output: If executed with no parameters, a numeric value will be returned indicating whether the battery service is
enabled (1) or disabled (0).

D This command requires a system reset to take effect.

# Enable the Battery Service
AT+BLEBATTEN=1
0K

AT+BLEBATTVAL

Sets the current battery level in percentage (0..100) for the Battery Service (if enabled).
Codebase Revision: 0.7.0
Parameters: The percentage for the battery in the range of 0..100.

Output: If executed with no parameters, the current battery level stored in the characteristic.

# Set the battery level to 72%
AT+BLEBATTVAL=72
0K
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ﬁ adafruit learning system
BLE GAP

GAP (https://adafru.it/iCo), which stands for the Generic Access Profile, governs advertising and connections with
Bluetooth Low Energy devices.

The following commands can be used to configure the GAP settings on the BLE module.
You can use these commands to modify the advertising data (for ex. the device name that appears during the

advertising process), to retrieve information about the connection that has been established between two devices, or
the disconnect if you no longer wish to maintain a connection.

AT+GAPCONNECTABLE

This command can be used to prevent the device from being 'connectable’.

Codebase Revision: 0.7.0

Parameters: Whether or not the device should advertise itself as connectable, using one of the following values:
® vyes
® no
o 1

® 0

Output: The 'connectable' state of the device if no parameter is provided

# Make the device non-connectable (advertising only)
AT+GAPCONNECTABLE=0
0K

# Check the current connectability status
AT+GAPCONNECTABLE

1

0K

AT+GAPGETCONN

Diplays the current connection status (if we are connected to another BLE device or not).
Codebase Revision: 0.3.0
Parameters: None

Output: 1if we are connected, otherwise O
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# Connected
AT+GAPGETCONN
1

0K

# Not connected
AT+GAPGETCONN

0

0K

AT+GAPDISCONNECT

Disconnects to the external device if we are currently connected.
Codebase Revision: 0.3.0
Parameters: None

Output: None

AT+GAPDISCONNECT
0K

AT+GAPDEVNAME

Gets or sets the device name, which is included in the advertising payload for the Bluefruit LE module
Codebase Revision: 0.3.0
Parameters:

® None to read the current device name
® The new device name if you want to change the value

Output: The device name if the command is executed in read mode

Updating the device name will persist the new value to non-volatile memory, and the updated name will be

used when the device is reset. To reset the device to factory settings and clean the config data from memory
run the AT+FACTORYRESET command.

# Read the current device name
AT+GAPDEVNAME

UART

0K

# Update the device name to 'BLEFriend’
AT+GAPDEVNAME=BLEFriend

0K

# Reset to take effect

ATZ

0K
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AT+GAPDELBONDS

Deletes and bonding information stored on the Bluefruit LE module.
Codebase Revision: 0.3.0
Parameters: None

Output: None

AT+GAPDELBONDS
OK

AT+GAPINTERVALS

Gets or sets the various advertising and connection intervals for the Bluefruit LE module.

Be extremely careful with this command since it can be easy to cause problems changing the intervals, and depending
on the values selected some mobile devices may no longer recognize the module or refuse to connect to it.

Codebase Revision: 0.3.0
Parameters: If updating the GAP intervals, the following comma-separated values can be entered:

Minimum connection interval (in milliseconds)

Maximum connection interval (in milliseconds)

Fast Advertising interval (in milliseconds)

Fast Advertising timeout (in seconds)

>=0.7.0: Low power advertising interval (in milliseconds), default = 417.5 ms

To save power, the Bluefruit modules automatically drop to a lower advertising rate after 'fast advertising
timeout' seconds. The default value is 30 seconds ('Fast Advertising Timeout'). The low power advertising

interval is hard-coded to approximately 0.6s in firmware < 0.7.0. Support to control the low power interval was
added in the 0.7.0 firmware release via an optional fifth parameter.

Please note the following min and max limitations for the GAP parameters:

Absolute minimum connection interval: 10ms

Absolute maximum connection interval: 4000ms

Absolute minimum fast advertising interval: 20ms

Absolute maximum fast advertisting interval: 10240ms
Absolute minimum low power advertising interval: 20ms
Absolute maximum low power advertising interval: 10240ms

I:l If you only wish to update one interval value, leave the other comma-separated values empty (ex. ',,110," will

only update the third value, advertising interval).

Output: If reading the current GAP interval settings, the following comma-separated information will be displayed:
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Minimum connection interval (in milliseconds)
Maximum connection interval (in milliseconds)
Advertising interval (in milliseconds)
Advertising timeout (in milliseconds)

Updating the GAP intervals will persist the new values to non-volatile memory, and the updated values will be

used when the device is reset. To reset the device to factory settings and clean the config data from memory
run the AT+FACTORYRESET command.

# Read the current GAP intervals
AT+GAPINTERVALS
20,100,100,30

# Update all values
AT+GAPINTERVALS=20,200,200,30
0K

# Update only the advertising interval

AT+GAPINTERVALS=, , 150,
0K

AT+GAPSTARTADV

Causes the Bluefruit LE module to start transmitting advertising packets if this isn't already the case (assuming we

aren't already connected to an external device).
Codebase Revision: 0.3.0
Parameters: None

Output: None

# Command results when advertising data is not being sent
AT+GAPSTARTADV

0K

# Command results when we are already advertising
AT+GAPSTARTADV

ERROR

# Command results when we are connected to another device

AT+GAPSTARTADV
ERROR

AT+GAPSTOPADV

Stops advertising packets from being transmitted by the Bluefruit LE module.
Codebase Revision: 0.3.0

Parameters: None
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Output: None

AT+GAPSTOPADV
0K

AT+GAPSETADVDATA

Sets the raw advertising data payload to the specified byte array (overriding the normal advertising data), following the
guidelines in the Bluetooth 4.0 or 4.1 Core Specification (https://adafru.it/ddd).

In particular, Core Specification Supplement (CSS) v4 contains the details on common advertising data fields like
'Flags' (Part A, Section 1.3) and the various Service UUID lists (Part A, Section 1.1). A list of all possible GAP Data Types
is available on the Bluetooth SIG's Generic Access Profile (https://adafru.it/cYs) page.

The Advertising Data payload consists of Generic Access Profile (https://adafru.it/cYs) data that is inserted into the
advertising packet in the following format: [U8:LEN] [U8:Data Type Value] [n:Value]

WARNING: This command requires a degree of knowledge about the low level details of the Bluetooth 4.0 or
4.1 Core Specification, and should only be used by expert users. Misuse of this command can easily cause
your device to be undetectable by central devices in radio range.

WARNING: This command will override the normal advertising payload and may prevent some services from
acting as expected.

|:| To restore the advertising data to the normal default values use the AT+FACTORYRESET command.

For example, to insert the 'Flags' Data Type (Data Type Value 0x01), and set the value to Ox06/0b00000110 (BR/EDR
Not Supported and LE General Discoverable Mode) we would use the following byte array:

02-01-06

® (0Ox02 indicates the number of bytes in the entry

® OxO1is the 'Data Type Value (https://adafru.it/cYs)' and indicates that this is a 'Flag'

® 0Ox06 (ObO0000110) is the Flag value, and asserts the following fields (see Core Specification 4.0, Volume 3, Part
C,18.):

o LE General Discoverable Mode (i.e. anyone can discover this device)
o BR/EDR Not Supported (i.e. this is a Bluetooth Low Energy only device)

If we also want to include two 16-bit service UUIDs in the advertising data (so that listening devices know that we
support these services) we could append the following data to the byte array:

05-02-0D-18-0A-18
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0x05 indicates that the number of bytes in the entry (5)
0x02 is the 'Data Type Value (https://adafru.it/cYs)' and indicates that this is an 'Incomplete List of 16-bit Service
Class UUIDs'
® (0OxO0D 0x18 is the first 16-bit UUID (which translates to 0x180D, corresponding to the Heart Rate
Service (https://adafru.it/ddB)).
® (OxOA Ox18 is another 16-bit UUID (which translates to Ox180A, corresponding to the Device Information
Service (https://adafru.it/ecj)).

Including the service UUIDs is important since some mobile applications will only work with devices that

advertise a specific service UUID in the advertising packet. This is true for most apps from Nordic
Semiconductors, for example.

Codebase Revision: 0.3.0

Parameters: The raw byte array that should be inserted into the advertising data section of the advertising packet,
being careful to stay within the space limits defined by the Bluetooth Core Specification.

Response: None

# Advertise as Discoverable and BLE only with 16-bit UUIDs 0x180D and 0x180A
AT+GAPSETADVDATA=02-01-06-05-02-0d-18-0a-18
0K

The results of this command can be seen in the screenshot below, taken from a sniffer analyzing the advertising
packets in Wireshark. The advertising data payload is higlighted in blue in the raw byte array at the bottom of the
image, and the packet analysis is in the upper section:

~
Bluetooth Low Energy Link Layer
Access Address: 0xB8eB89bed6
P Packet Header: ©x0f40 (PDU Type: ADV_IND, TxAdd=false, RxAdd=false)
Advertising Address: ed:c6:c7:31:95:11 (ed:c6:c7:31:95:11)
-

= Flags
Length: 2
Type: Flags (0x01)
000, ... Reserved: 0x00
Y B, Simultaneous LE and BR/EDR to Same Device Capable (Host): false (0x00)

R Simultaneous LE and BR/EDR to Same Device Capable (Controller): false (0x00)
.1,. = BR/EDR Not Supported: true (0x01)
L LE General Discoverable Mode: true (0x01)

.... ...0 = LE Limited Discoverable Mode: false (0x00)

= 16-bit Service Class UUIDs (incomplete)
Length: 5
Type: 16-bit Service Class UUIDs (incomplete) (0x02)
UUID 16: Heart Rate (0x180d)
UUID 16: Device Information (0x180a)

4
0000 00 06 22 01 8b 17 06 ©a 01 26 2b 00 00 97 02 00 o e,
0016 00 d6 be 89 Be 40 Of 11 95 31 c7 cb ed : a -
0020 c9 od 00 .
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* adafruit learning system
BLE GATT

GATT (https://adafru.it/iCp), which standards for the Generic ATTribute Profile, governs data organization and data
exchanges between connected devices. One device (the peripheral) acts as a GATT Server, which stores data in
Attribute records, and the second device in the connection (the central) acts as a GATT Client, requesting data from
the server whenever necessary.

The following commands can be used to create custom GATT services and characteristics on the BLEFriend, which are
used to store and exchange data.

Please note that any characteristics that you define here will automatically be saved to non-volatile FLASH config
memory on the device and re-initialised the next time the device starts.

|:| You need to perform a system reset via 'ATZ' before most of the commands below will take effect!

GATT Limitations

The commands below have the following limitations due to SRAM and resource availability, which should be kept in
mind when creating or working with customer GATT services and characteristics.

These values apply to firmware 0.7.0 and higher:

Maximum number of services: 10

Maximum number of characteristics: 30

Maximum buffer size for each characteristic: 32 bytes
Maximum number of CCCDs: 16

If you want to clear any previous config value, enter the 'AT+FACTORYRESET' command before working on a new
peripheral configuration.

AT+GATTCLEAR

Clears any custom GATT services and characteristics that have been defined on the device.
Codebase Revision: 0.3.0

Parameters: None

Response: None

AT+GATTCLEAR
0K

AT+GATTADDSERVICE

Adds a new custom service definition to the device.

Codebase Revision: 0.3.0
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Parameters: This command accepts a set of comma-separated key-value pairs that are used to define the service
properties. The following key-value pairs can be used:

® UUID: The 16-bit UUID to use for this service. 16-bit values should be in hexadecimal format (Ox1234).
® UUID128: The 128-bit UUID to use for this service. 128-bit values should be in the following format: 00-11-22-33-
44-55-66-77-88-99-AA-BB-CC-DD-EE-FF

Response: The index value of the service in the custom GATT service lookup table. (It's important to keep track of
these index values to work with the service later.)

I:l Note: Key values are not case-sensitive

|:| Only one UUID type can be entered for the service (either UUID or UUID128)

# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

0K

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19, PROPERTIES=0x10,MIN LEN=1,VALUE=100

1

0K

# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1

0K

# Add a custom characteristic to the above service (making sure that there

# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002, PROPERTIES=0x02,MIN LEN=1,VALUE=100

1

0K

AT+GATTADDCHAR

Adds a custom characteristic to the last service that was added to the peripheral (via AT+GATTADDSERVICE).

|:| AT+GATTADDCHAR must be run AFTER AT+GATTADDSERVICE, and will add the new characteristic to the

last service definition that was added.
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As of version 0.6.6 of the Bluefruit LE firmware you can now use custom 128-bit UUIDs with this command.

See the example at the bottom of this command description.

Codebase Revision: 0.3.0

Parameters: This command accepts a set of comma-separated key-value pairs that are used to define the
characteristic properties. The following key-value pais can be used:

® UUID: The 16-bit UUID to use for the characteristic (which will be insert in the 3rd and 4th bytes of the parent
services 128-bit UUID). This value should be entered in hexadecimal format (ex. 'UUID=0x1234'). This value must
be unique, and should not conflict with bytes 3+4 of the parent service's 128-bit UUID.

® PROPERTIES: The 8-bit characteristic properties field, as defined by the Bluetooth SIG. The following values can
be used:

0x02 - Read

0x04 - Write Without Response
0x08 - Write

0x10 - Notify

0x20 - Indicate

O O O O o

MIN_LEN: The minimum size of the values for this characteristic (in bytes, min =1, max = 20, default =1)
MAX_LEN: The maximum size of the values for the characteristic (in bytes, min =1, max = 20, default = 1)

® VALUE: The initial value to assign to this characteristic (within the limits of 'MIN_LEN' and 'MAX_LEN'). Value can
be aninteger ("-100", "27"), a hexadecimal value ("OxABCD"), a byte array ("aa-bb-cc-dd") or a string ("GATT!").

® >=0.7.0 - DATATYPE: This argument indicates the data type stored in the characteristic, and is used to help
parse data properly. It can be one of the following values:

AUTO (0, default)
STRING (1)
BYTEARRAY (2)
INTEGER (3)

O O O O

® >=0.7.0 - DESCRIPTION: Adds the specified string as the characteristic description entry
® >=0.7.0 - PRESENTATION: Adds the specified value as the characteristic presentation format entry

Response: The index value of the characteristic in the custom GATT characteristic lookup table. (It's important to keep
track of these characteristic index values to work with the characteristic later.)

|:| Note: Key values are not case-sensitive

I:l Make sure that the 16-bit UUID is unique and does not conflict with bytes 3+4 of the 128-bit service UUID
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# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

0K

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19, PROPERTIES=0x10,MIN LEN=1,VALUE=100

1

0K

# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1

0K

# Add a custom characteristic to the above service (making sure that there

# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002, PROPERTIES=0x02,MIN LEN=1,VALUE=100

1

0K

Version 0.6.6 of the Bluefruit LE firmware added the ability to use a new 'UUID128' flag to add custom 128-bit UUIDs
that aren't related to the parent service UUID (which is used when passing the 16-bit 'UUID' flag).

To specify a 128-bit UUID for your customer characteristic, enter a value resembling the following syntax:

# Add a custom characteristic to the above service using a

# custom 128-bit UUID
AT+GATTADDCHAR=UUID128=00-11-22-33-44-55-66-77-88-99-AA-BB-CC-DD-EE-
FF,PROPERTIES=0x02,MIN LEN=1,VALUE=100

1

0K

Version 0.7.0 of the Bluefruit LE firmware added the new DESCRIPTION and PRESENTATION keywoards,
corresponding the the GATT Characteristic User Description (https://adafru.it/olA) and the GATT Characteristic
Presentation Format (https://adafru.it/olB) Descriptors.

The DESCRIPTION field is a string that contains a short text description of the characteristic. Some apps may not
display this data, but it should be visible using something like the Master Control Panel application from Nordic on iOS
and Android.

The PRESENTATION field contains a 7-byte payload that encapsulates the characteristic presentation format data. It
requires a specific set of bytes and values to work properly. See the following link for details on how to format the
payload: https://developer.bluetooth.org/gatt/descriptors/Pages/DescriptorViewer.aspx?
u=org.bluetooth.descriptor.gatt.characteristic_presentation_format.xml (https://adafru.it/olB)
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The following example shows how you might use both of these new fields:

AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_ LEN=2, MAX LEN=3, VALUE=00-40,
DESCRIPTION=HRM Measurement, PRESENTATION=17-00-AC-27-01-00-00

For the Characteristic Presentation Format we have:

® Format = IEEE-11073 32-bit FLOAT (Decimal 23, Hex 0x17)

® Exponent=0/None

® Unit = Thermodynamic temperature: Degrees Fahrenheit (0x27AC) - Bluetooth LE Unit List (https://adafru.it/olD)
® Namespace = Bluetooth SIG Assigned Number (0Ox01)

® Description = None (0x0000)

The results from Nordic's Master Control Panel app can be seen below:

| [Bond | [Update ~| [Discover senvices | | Enable services | [ DFU_|

Senvice Discovery
Software Ravision String, Value: 30-2E-37-2E-30-20-20-20-44-75-6E-20-32-38-20-32-30-31:36 -
= CharectedsticDeclaration. Value: 02-1C-00-26-2A, Properies: Read. Charactenstic UUID: 1x2A26
Fimware Revision String, Value: 53-31-31-30-20-38-2E-30-2E-30-2C-20-30-2E-32
5 CharacteristicDeclaration, Value: 02-1E-00-27-2A, Properties: Read, Characteristic UUID: Ba2A27
| Hardware Revision String, Value: 51-4641-43-41-31-30
= PrmaryService. Value: SE-CA-DC-24-0E-EFAS-EN93-FI-AT-B5-01-00-40-6E. UART over BLE (BxGE400001-B5A3F393-E0AF-ESOE24DCCAIE)

(= CharactedsticDeclaration, Value: 10-21-00-9E-CA-DC-24-08-E5-AS-E0-93-F2-A3-B5-03-00-40-6E, Propesties: Notify, C+ stic ULUID: B5A3-FI93-E0ASH ADCCASE
UART TX. Vakue:
- CharactensticUsarDescription, Value: 54-58-44, UserDescription: TXD
-ChientCh i Value: 00-D0. Ch Hone (0000}

(= CharactedsticDeclaration, Value: 0C-25-00-98-CA-DC-24-0E-E5-AS-EQ-93-F3-A3-B5-02-00-40-5E, Propedies: , Wirite, CH istic UUID: B5AZ-FI93-E
UART R, (Mo values read) =
CharzctensticUserDesenption, Value: 52-58-44, UserDescription: RXD

(=) Primary Sesvice. Value: 0D-18. Heart Rate (x1800)
- CharactersticDeclaration, Value: 10-25-00-37-2A, Propedies: Notify, Characteristic UUID: (x2A37
|- Heart Rate Measurement Value: 00-60
CharactenisticUserDesenption, Value: 43-52-4D-20-4D-65-61-73-75-72 65-60-65-6E-74, UserDescription: HRM Measurement
- ClertCh . Value: 00-00, Ch None (0000}
CharactersticFommat, Vishue: 17-00-AC-27-01-00-00, Format: Float, Eponent: 0, Unit: (27AC, NameSpace: (01, Description: (k00!

(= CharactensticDaclaration, Value: 02-2E-00-18-2A, Properties: Read, Charactenstic LIUID: (x2438

'~ Heart Rate Sensor Location, Value: 03 -
1 *

AT+GATTCHAR

Gets or sets the value of the specified custom GATT characteristic (based on the index ID returned when the
characteristic was added to the system via AT+GATTADDCHAR).

Codebase Revision: 0.3.0

Parameters: This function takes one or two comma-separated functions (one parameter = read, two parameters =
write).

® The first parameter is the characteristic index value, as returned from the AT+GATTADDCHAR function. This
parameter is always required, and if no second parameter is entered the current value of this characteristic will
be returned.

® The second (optional) parameter is the new value to assign to this characteristic (within the MIN_SIZE and
MAX_SIZE limits defined when creating it).

Response: If the command is used in read mode (only the characteristic index is provided as a value), the response will

display the current value of the characteristics. If the command is used in write mode (two comma-separated values
are provided), the characteristics will be updated to use the provided value.
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# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

0K

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19, PROPERTIES=0x10,MIN LEN=1,VALUE=100

1

0K

# Read the battery measurement characteristic (index ID = 1)
AT+GATTCHAR=1

0x64

0K

# Update the battery measurement characteristic to 32 (hex 0x20)
AT+GATTCHAR=1, 32
0K

# Verify the previous write attempt
AT+GATTCHAR=1

0x20

0K

AT+GATTLIST

Lists all custom GATT services and characteristics that have been defined on the device.

Codebase Revision: 0.3.0
Parameters: None

Response: A list of all custom services and characteristics defined on the device.
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# Clear any previous custom services/characteristics
AT+GATTCLEAR
0K

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

0K

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19, PROPERTIES=0x10,MIN LEN=1,VALUE=100

1

0K

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
2

0K

# Add a custom characteristic to the above service (making sure that there

# is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002, PROPERTIES=0x02,MIN LEN=1,VALUE=100

2

0K

# Get a list of all custom GATT services and characteristics on the device
AT+GATTLIST
ID=01,UUID=0x180F
ID=01,UUID=0x2A19,PROPERTIES=0x10,MIN LEN=1,MAX LEN=1,VALUE=0x64
ID=02,UUID=0x11, UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
ID=02,UUID=0x02, PROPERTIES=0x02,MIN LEN=1,MAX LEN=1,VALUE=0x64
0K

AT+GATTCHARRAW

This read only command reads binary (instead of ASCIl) data from a characteristic. It is non-printable but has less
overhead and is easier when writing libraries in Arduino.

Codebase Revision: 0.7.0
Parameters: The numeric ID of the characteristic to display the data for

Output: Binary data corresponding to the specified characteristic.

|:| Note: This is a specialized command and no NEWLINE is present at the end of the command!

© Adafruit Industries https://learn.adafruit.com/adafruit-feather-m0-bluefruit-le Page 151 of 223



* adafruit learning system
Debug

The following debug commands are available on Bluefruit LE modules:

|:| Use these commands with care since they can easily lead to a HardFault error on the ARM core, which will

cause the device to stop responding.

AT+DBGMEMRD

Displays the raw memory contents at the specified address.
Codebase Revision: 0.3.0
Parameters: The following comma-separated parameters can be used with this command:

® The starting address to read memory from (in hexadecimal form, with or without the leading '0x')
® The word size (can be 1, 2, 4 or 8)
® The number of words to read

Output: The raw memory contents in hexadecimal format using the specified length and word size (see examples
below for details)

# Read 12 1-byte values starting at 0x10000009
AT+DBGMEMRD=0x10000009,1,12

FF FF FF FF FF FF FF 00 04 00 00 00

0K

# Try to read 2 4-byte values starting at 0x10000000
AT+DBGMEMRD=0x10000000,4,2

55AA55AA 55AA55AA

0K

# Try to read 2 4-byte values starting at 0x10000009

# This will fail because the Cortex MO can't perform misaligned
# reads, and any non 8-bit values must start on an even address
AT+DBGMEMRD=0x10000009, 4,2

MISALIGNED ACCESS
ERROR

AT+DBGNVMRD

Displays the raw contents of the config data section of non-volatile memory
Codebase Revision: 0.3.0
Properties: None

Output: The raw config data from non-volatile memory
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AT+DBGNVMRD
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AT+DBGSTACKSIZE

Returns the current stack size, to help detect stack overflow or dete